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Legal information

Warning notice system
This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

CAUTION
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

NOTICE
indicates that an unintended result or situation can occur if the corresponding information is not taken into account.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation for the specific task, in particular its warning notices and safety 
instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying 
risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be adhered to. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG
Industry Sector
Postfach 48 48
90026 NÜRNBERG
GERMANY
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WinCC/WebNavigator Installation Notes 1
1 Resources

1.1 Welcome

Dear WinCC Customer:
With SIMATIC WinCC/WebNavigator , you can run and supervise your WinCC system via the 
Intranet or Internet. You can use your projects previously created with WinCC.

The WinCC/WebNavigator client is a so-called thin client which, integrated in the Internet 
Browser on a client PC, enables ongoing WinCC projects to be run and supervised without 
needing the entire WinCC Basic system to be installed on the PC. Additional configuration of 
the WebNavigator Client is not required. The project and the associated WinCC application 
are located on a server computer.

The operating system requirements of the WinCC/WebNavigator server are the same as those 
of the WinCC server.

When using WinCC/WebNavigator, please note the restrictions mentioned in this document.

We wish you much success and joy when using SIMATIC WinCC.

Regards, Your WinCC/WebNavigator Team

1.2 General information

Software Information Service
If you return the "WinCC Software Information Service" card, you will automatically receive the 
latest information on all SIMATIC WinCC products free of charge.

Information about licensing terms
Please observe the license conditions which appear during the installation process.

Please contact your Siemens AG representative for further information.

MDM - WinCC/WebNavigator
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Contents of the WinCC DVD for WinCC/WebNavigator
● WebNavigator Client-side Controls

● WebNavigator Diagnose Client Control

● WebNavigator Server Software

● Documentation

● Release notes

● WinCC Remote Publisher

● WebNavigator Plug-In Builder

● Demo Project

1.3 Requirements

1.3.1 Hardware and Software

Introduction
This chapter describes the hardware and operating system requirements for WinCC/
WebNavigator. 

Note

A WebNavigator server cannot be operated on a WinCC client without a project of its own.

WinCC WebNavigator Client

Table 1-1 Hardware

  Minimum Recommended

CPU Pentium II; 300 MHz E.g. Intel Core 2 Duo, AMD Athlon64
Working memory 256 MByte 1 GByte

WinCC/WebNavigator Installation Notes
1.3 Requirements
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Table 1-2 Software 

Operating System: Windows Vista SP1 Basic, Home, Ultimate, Enterprise, 
Business          ‌
Windows XP Professional SP3          ‌
Windows Server 2003 SP2 or Server 2003 R2 SP2         ‌
Other operating systems such as WinCE or Win95 via MS Terminal 
Services
Embedded XP in connection with Panel PC 477

Software: Internet Explorer V6.0 SP1, V6.0 SP2 or V7.0         ‌
If you wish to use .NET and XAML controls, you must install .NET 
Framework 3.0.

Other: Access to the intranet/Internet         ‌
or TCP/IP connection to the Web server 

WinCC/WebNavigator Server on a WinCC Single-User System 

Table 1-3 Hardware

  Minimum Recommended

CPU Pentium III; 1 GHz E.g. Intel Core 2 Duo, AMD Athlon64
Working memory 1 GByte 2 GByte

Table 1-4 Software

Operating System: Windows Vista SP1 Enterprise, Ultimate, Business         ‌
Windows XP Professional SP3 (max. 3 clients)          ‌
Windows Server 2003 SP2 or Server 2003 R2 SP2

Software: Internet Explorer V6.0 SP1, V6.0 SP2 or V7.0         ‌
WinCC Basic System V7.0 SP1

Other: Access to the intranet/Internet          ‌
or TCP/IP connection to the Web client 

WinCC/WebNavigator Server on WinCC Server or WinCC Client with its own Project

Table 1-5 Hardware

  Minimum Recommended

CPU Pentium III; 1 GHz E.g. Intel Core 2 Duo, AMD Athlon64
Working memory 1 GByte >1 GByte

WinCC/WebNavigator Installation Notes
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Table 1-6 Software

Operating System: Windows Server 2003 SP2 or Server 2003 R2 SP2
Software: Internet Explorer V6.0 SP1, V6.0 SP2 or V7.0         ‌

WinCC Basic System V7.0 SP1
Other: If you want to publish intranet information, the following is required:

A network-capable computer as well as a LAN connection (LAN = 
Local Area Network).
A system that breaks up computer names into IP addresses (IP = 
Internet Protocol). This is not a mandatory step, but it allows users to 
use "alias names" instead of IP addresses when connecting to your 
server.
If you want to publish Internet information, the following is required:
An Internet connection and an IP address from your Internet service 
provider (ISP). You can only publish information in the Internet, if you 
have a connection to the Internet (provided by the ISP).
A high-performance network card that is suitable for connecting to the 
Internet.
A DNS registration (DNS = Domain Name System) for your IP 
address. This is not a mandatory step, but it allows users to use "alias 
names" instead of IP addresses when connecting to your server.

1.3.2 Licensing

WinCC/WebNavigator client
No license is required for the PC on which the WebNavigator Client is running, as server 
licenses are available on the Web server. 

WinCC/WebNavigator Server
As a prerequisite for the WinCC basic system, the WinCC RT basic license is required. No 
WinCC server license is required, if no local WinCC clients are operated. Even when operating 
a WinCC client as a dedicated web server, no WinCC server license is required for the WinCC 
client. 

The WinCC/WebNavigator Server runs without a license in Demo mode for 30 days.         ‌
A license is required, however, if you want to use the WinCC/WebNavigator Server in the long 
term. Licenses are available for 3, 10, 25 or 50 clients that can simultaneously access the web 
server. 

If the number of licensed clients is exceeded during a login attempt by a web client, a message 
is displayed and no further logins be permitted.

WinCC/WebNavigator Diagnostics Client
Other licenses are required in order for the WebNavigator Diagnostics Client to function. For 
more information, please refer to the section on the "WebNavigator Diagnostics Client".

WinCC/WebNavigator Installation Notes
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Overview of Licenses for WebNavigator Server and Client

Server Client no License Client with Diagnose client 
license 

WN server license +          ‌
WinCC license

WN client          ‌
To max. number of licenses 
(server)

Diagnose client          ‌
One license per Diagnose 
client 

WN Diagnose server license +          ‌
WinCC license

Demo client          ‌
Unlimited number

Diagnose client          ‌
One license per Diagnose 
client

No WN license or          ‌
no WinCC license

Demo client          ‌
Unlimited number

Demo client          ‌
Unlimited number

WN server license +          ‌
WinCC license +         ‌
"Load Balancing" license

WN client          ‌
To max. number of licenses 
(server)

Diagnose client          ‌
One license per Diagnose 
client

WN server license +          ‌
WinCC license +         ‌
WinCC redundancy license +         ‌
"Load Balancing Step-Up" license

WN client          ‌
To max. number of licenses 
(server)

Diagnose client          ‌
One license per Diagnose 
client

Restarting the Web Client after License Modification
If the WebNavigator licenses on the web server are modified, e.g. to a different number of 
clients, Internet Explorer must be restarted on each connected web client, and the web client 
must log in again. If this is not done, the web client switches to demo mode. This also applies 
to automatic reconnect of the web client.

See also
Diagnose Client Licensing (Page 27)

1.3.3 Requirements for the Diagnostics Client
This chapter describes the hardware and software requirements for the use of the 
WebNavigator Diagnostics Client.

Operating System: Windows XP Professional SP3         ‌
Windows Server 2003 SP2 or Server 2003 R2 SP2         ‌
Windows Vista SP1

Software: Internet Explorer V6.0 SP1, V6.0 SP2 or V7.0
Other: Access to Intranet / Internet.

Note

You need to have "Administrator" rights to install the Clients Diagnosis.

WinCC/WebNavigator Installation Notes
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1.3.4 Requirements for the Use of Terminal Services
This chapter outlines the hardware, software and operating system requirements for using 
terminal services and WinCC/Web Navigator.

Terminal Server

Table 1-7 Hardware

  Minimum Recommended

CPU Pentium III; 1 GHz E.g. Intel Core 2 Duo, AMD Athlon64
Working memory 1 GByte >1 GByte

Note

It needs to be noted that each client terminal increases the memory requirements and the 
processor load. It therefore needs to be ensured that the terminal server has adequate 
memory and processor load reserves. 

Table 1-8 Software

Operating system Windows Server 2003 SP2 or Server 2003 R2 SP2: It must be 
possible to call up and execute applications that are to be executed 
on the clients multiple times.

Other: If many users want to access the server, then you need to use a high 
performance network card. 

Terminal Server Clients

Minimum Client Requirements: Network card with TCP/IP         ‌
Terminal client RDP 5.0         ‌
Display or screen         ‌
Pointing device

The device recommended for use as a client is: SIMATIC Mobile Panel PC 12".

WinCC/WebNavigator Installation Notes
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Note

WebNavigator Client is released for Windows Terminal Services. A maximum of 25 sessions 
per terminal server are permitted.

Please note when running Windows Server 2003: As is the case with Windows Server 2003 
CALs there are two different terminal service CALs: TS devices CAL and TS users 
CAL.         ‌
The TS Device CAL enables a device to run user-independent Windows sessions on a 
Windows Server 2003. The TS User CAL enables a user to run device-independent Windows 
sessions on a Windows Server 2003.

A Windows Server 2003 Terminal Server CAL "TS CAL" is required for every user or every 
device. 

Please go to "http://www.microsoft.com/resources/sam/lic_cal.mspx" for more information.

See also
http://www.microsoft.com/resources/sam/lic_cal.mspx (http://www.microsoft.com/resources/
sam/lic_cal.mspx)

1.3.5 Mixture and compatibility of versions

Mixing WebNavigator Versions
If you wish to install a WebNavigator client on a WebNavigator server, the two must both have 
the same version. 

Versions of WinCC/WebNavigator and WinCC Basic System
WebNavigator Version 7.0 SP1 is released only on the basis of WinCC V7.0 SP1.

The WebNavigator Server/Client version V7.0 SP1 must not be installed on a PC with a version 
of WinCC older than V7.0 SP1. 

Likewise, a version of WebNavigator Server/Client older than V7.0 SP1 must not be installed 
on a PC with WinCC version 7.0 SP1.

Connecting a Web Client to an Older Version WebNavigator Server
If you wish to connect a WebNavigator Client V7.0 SP1 to an older version of a WebNavigator 
Server, e.g. V6.0, the Web Client must previously have successfully logged on to a Web Server 
of the same version. The Web Client can then be subsequently logged in error-free on an older 
version of a Web Server.

If the web client was connected first of all to the older web server version, delete the 
"CheckInstallation Class" file in "Internet Options / Temporary Internet Files / Settings / Display 
Objects" in the Internet Explorer of the web client.

WinCC/WebNavigator Installation Notes
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1.4 Installation of the WinCC/Web Navigator Server

1.4.1 Procedure

Introduction
This chapter describes the installation of the WebNavigator Server.

Requirements
The following requirements must be met for installation:

● A released Windows operating system has been installed.

● WinCC Basic is installed.

You can find further information about released operating systems for WebNavigator in the 
section "Requirements > Hardware and Software".

Details of the WinCC installation may be found in the WinCC documentation.

Installation Overview
1. Installation of the Internet Information Server (IIS).

2. Installation of the WinCC/WebNavigator Server.

Note
Requires administrator rights

In order to install the server components of the WinCC/WebNavigator under Windows, you 
will need write access for the registration database.  To do this, you must have administrator 
rights.
WinCC options previously installed

If you have already installed other WinCC options prior to the installation of WinCC/
WebNavigator, such as WinCC/DowntimeMonitor or WinCC/ProcessMonitor, you may have 
to retro-install these options.

Using WinCC/DataMonitor: Installation Order for Windows XP
When installing a Web server on a computer with Windows XP, adhere to the following 
installation order:

1. Install the Internet Information Service (IIS).

2. Install the SQL server.

Error messages may occur if the installation order is not maintained when opening DataMonitor 
Reports in WinCC/DataMonitor.

WinCC/WebNavigator Installation Notes
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In this happens, correct the problem as follows:

1. Start the "Web Configurator" in the Windows Start menu by selecting "SIMATIC > WinCC 
> Web Configurator" and configure the Web server.

2. Start the SIMATIC Security Control in the Windows start menu by selecting "SIMATIC > 
Simatic Security Control" and configure the security settings.

See also
Installation of the Internet Information Service (IIS) (Page 15)

Installation of the WinCC/Web Navigator Server (Page 16)

1.4.2 Installation of the Internet Information Service (IIS)

Settings
Under Windows Vista you will first have to install the Internet Information Service (IIS) before 
you install the WinCC/WebNavigator server. You will specify the settings for the WebNavigator 
server during installation.

Activate the following settings under Windows Vista:

● Web management tools:

– IIS management service

– IIS management console

– IIS management scripts and tools

– Compatibility with IIS Metabasis and IIS 6 configuration

– Compatibility with WMI for IIS 6

● WWW services > General HTTP features:

– Standard document

– Static content

● WWW services > Application development features:

– ASP

– ISAPI extensions

– ISAPI filters

● WWW services > Security:

– Requirement filtering

– Standard authentication
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Note

If the logging functions are active with IIS, the log files must be monitored and deleted, if 
necessary. The event views should be configured so that the log files do not become too 
large.

 

Requirements
● Administrator rights

● Write access for the registration database

Procedure
1. Insert the Windows CD-ROM into the drive.

2. From the Windows start menu, select the entry "Settings" > "Control Panel."

3. Click the "Software" icon.

4. Open the "Add or Remove Programs" dialog and click "Add or Remove Windows 
Components".

5. Activate the settings listed above under Windows Vista.
You can also use the command line "Start > Run > cmd" to install the IIS components 
located on the installation CD:
pkgmgr.exe /iu:IIS-WebServerRole;IIS-WebServer;IIS-CommonHttpFeatures;IIS-
StaticContent;IIS-DefaultDocument;IIS-HttpErrors;IIS-ASPNET;IIS-ASP;IIS-
ISAPIExtensions;IIS-ISAPIFilter;IIS-BasicAuthentication;IIS-WindowsAuthentication;IIS-
ManagementConsole;IIS-ManagementService;IIS-IIS6ManagementCompatibility;IIS-
Metabase;IIS-WMICompatibility

6. Close the dialog with the "OK" button. The required data is transferred and the IIS is 
configured accordingly.

1.4.3 Installation of the WinCC/Web Navigator Server

Requirements
● To do this, you must have administrator rights.

Proceed as follows
1. Insert the WinCC DVD in the drive.

The DVD starts automatically if Autorun is enabled in the operating system. If the autorun 
function is disabled, start the Setup.exe program on the DVD.

2. In the "Installation Type" dialog, select "Package Installation".

WinCC/WebNavigator Installation Notes
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3. Select the "WebNavigator Server" installation.

4. Restart the installation.
You can track the status of the installation in the displayed dialog. Select "Cancel" to cancel 
the installation.

5. You can transfer the license key for the product after installation of the WinCC/
WebNavigator server. To do so, click on "Transfer License Key." Select "Next" if you have 
already transferred the license key or want to install it at a later time.

Note

License keys will not be transferred automatically. You will have to transfer missing license 
keys during or after installation with Automation License Manager .

6. At the end of the installation process, the security settings that are adapted for WinCC are 
displayed in the "SIMATIC Security Control" dialog. The firewall is configured automatically.
Confirm the changes with "Accept" and "Finish".

7. Restart the computer when prompted to do so by setup.
The WinCC/WebNavigator server is installed and has been added as a function in the 
navigation window of the WinCC Explorer.

Note
WinCC/WebNavigator is already installed

If an older WinCC/WebNavigator server has already been installed, it is recognized by 
the setup and installation is not possible. Uninstall the older version using the Windows 
Control Panel and restart the installation.

1.4.4 Upgrading the WebNavigator Server

Introduction
If a WebNavigator Server is already installed on the PC, this is detected by Setup if an attempt 
is made to install it again. 

Upgrading WebNavigator Server and WinCC Basic
It is only possible to upgrade a WebNavigator Server with a changed Service Pack number or 
version number if WinCC Basic is upgraded at the same time. 

During installation, the WebNavigator Server Setup carries out a check for older versions of 
WinCC Basic, and vice versa. Upon presence of an older version of the respective other 
software, setup displays a message to this fact.          ‌
This is why the upgrade has to be performed in the order described below. 

WinCC/WebNavigator Installation Notes
1.4 Installation of the WinCC/Web Navigator Server

MDM - WinCC/WebNavigator
System Manual, 11/2008,  17



Basic procedure
1. First of all, the installed WebNavigator Server software must be uninstalled in the Control 

Panel via "Software / Change or Remove Programs".

2. Install the new version of WinCC Basis as update without previous manual uninstallation.

3. The new version of WebNavigator Server is now installed.

1.5 Installation of the WinCC/Web Navigator Client

1.5.1 Installation of the WinCC/Web Navigator Client

Introduction
The following possibilities exist for installing the WinCC/WebNavigator Client (client-side 
controls). 

● Installation from the WinCC product DVD.          ‌
In this case, certain Windows user authorizations are necessary, depending on the 
operating system.

●  Installation via the intranet/Internet          ‌
In this case, certain Windows user authorizations are necessary, depending on the 
operating system.

● Optional installation options.          ‌
Installation is also possible without user interaction where software distribution is possible 
based on group guidelines under Windows user rights of the current user or in networks.

You can also install the WebNavigator Client additionally on your web server. This is for 
example useful, if you want to check your WinCC configuration locally on the server in the 
Internet Explorer.
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Basic procedure
The installation consists of the following steps:

1. Entry and check of the settings of the client computer in Internet Explorer.

2. Installation of the WebNavigator Client.

Note

When carrying out installation from the DVD or as software distribution based on group 
guidelines, an old version of the WebNavigator Client can be directly upgraded without 
having to uninstall the older web client first.         ‌
If a WebNavigator Server is installed after the WebNavigator Client on a PC, then the 
client will have to be installed again.

NOTICE

Plug-in reinstallation

With the installation of WebNavigatorClient V7.0, the plug-ins "User Archive Control", 
"Function Trend Control", "Hardcopy" and "Web Client" are already integrated in the 
WebNavigatorClient V7.0. If the WebNavigator Client V7.0 is connected to a web server 
older than V7.0, you will be offered these plug-ins in the Download area of the Web 
Navigation user interface, even though these plug-ins are already installed. Do not reinstall 
these plug-ins.

Information on the Setup and Installation of the WebNavigator Client:
● Before installing a newer version on the Web client via a download, check the languages 

installed on the Web client and connected Web server. After installing the web client via 
download, only the languages of the linked web server are available on the client computer.

● The WebNavigator Client Setup is interrupted with the error message "WinCC Active" if the 
local WinCC project is open or has been opened since the PC was last restarted. In this 
case, restart the computer.          ‌
Also check whether WinCC has been included in the Autostart directory. Remove the entry, 
if required and then restart to run the web client installation.

● To install the web client, you need minimum 70 MB free disk space on the hard disk, 
otherwise the MSI setup will cancel the installation with a corresponding error message.

● When installing the web client by downloading it from the Intranet/Internet, it is possible to 
select between "Open" and "Save" for the Setup file. The method selected for the initial 
installation of the Web client must also be selected a subsequent installation of Plug-Ins or 
ActiveX Controls, such as "User Archive Control", otherwise error message "Error 1316" 
appears in respect of the "MSI Installer" service.
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● In Windows XP, installation of the WebNavigator Client can be accelerated if you deactivate 
the setting "Search Automatically for Network Files and Printers" before you commence 
installation. To do so, open the "Folder Options" dialog using the menu item "Tools > Folder 
Options" in Windows Explorer. On the "View" tab register under "Files and Folders", 
deactivate this option and subsequently click on the "Apply to All Folders" button.

● In the download area of the Web Navigation user interface, the Plug-Ins which can be 
installed are displayed. For installation of this plug-in, at least the same minimum user 
authorizations are required as for installation of the web client.          ‌
If you select a plug-in in the Web Navigation user interface, the WebNavigator Client Setup 
starts. The Plug-In selection must be confirmed again.

Upgrading a Web Client from a previous version
The current version of the Web Client may be downloaded and installed from the website 
"www.wincc.de" on page "WinCC/WebNavigator" using the "Web Navigator Demo Project" 
link. 

Installing the Web Client under Windows Server
Installation of the web client under Windows Server with a lower user authorization than 
"Administrator" is not possible in the default setting of group policies.          ‌
You can release the web client installation in the group policy by assigning and making this 
software public or by activating the "Always install with higher rights" setting under 
"Administrative Templates / Windows Components / Windows Installer". You must activate 
"Never" for the "Deactivate Windows Installer" option.

1.5.2 User rights, user groups and optional installation possibilities

User rights, user groups and optional installation possibilities
This subject describes the following points in connection with the installation of the web client.

● Windows User Authorizations Required for Installation and First Registration of the Web 
Client

● Installing the Web Client with Limited Windows User Authorizations

● Installation for a configured group of users or computers

● Group policy based software distribution

● Installation without user interaction

Windows User Authorizations Required for Installation and First Registration of the Web Client
To install the Web Client via Intranet/Internet or using the product DVD, "Administrator" rights 
are required. The initial registration of the web client on the web server must take place with 
the same name as used during installation on the web server and must log on with the same 
or higher Windows user authorization. The connections must be established successfully. The 
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subsequent logins can then be performed under a different Windows user authorization with 
possibly limited rights. 

Installing the Web Client with Limited Windows User Authorizations
By using Microsoft Windows Installer technology (MSI), Web clients from Version V6.0 SP1 
can also be installed with limited Windows user authorizations i.e. without possessing the 
"Power user" or "Administrator" authorizations. 

This procedure can be set during the installation using the group policy based software 
distribution in networks.

The add-ins and plug-ins belonging to the Web Navigator client can also be installed this way. 
For plug-ins that were created with the WinCC Plug-In Builder, "Administrator" rights are 
required.

By using MSI technology, it is also possible to install the Web client for a configured group of 
users or computers.

Installation for a configured group of users or computers
Using the Microsoft Systems Management server or group policy on a Domain Controller, it is 
possible to install a group of users or computers configured by the Administrator.

● To do this, the "WinCCWebNavigatorClient.msi" MSI file is published in the Domain 
Controller and released for a user group. The installation is then performed according to 
the configuration of the group policy based software distribution either during login of the 
defined users or when the computer is started.

● When using a Microsoft Systems Management Server, the installation is configured by the 
administrator, triggered and executed when the relevant computer boots. Additional 
information on Microsoft Systems Management server is available in the Internet on the 
Microsoft home page.

Group policy based software distribution
The software installation is normally executed with the access rights of the current Windows 
user. When using MSI technology, the installation is performed by an operating system service 
with a higher level of rights. This enables installations to be performed for which the Windows 
user has no permission. Applications which require installations with a higher permission are 
referred to as "privileged installations" in MSI technology. Installation of these applications is 
possible when a Windows user is assigned the "Always install with elevated privileges" 
permission. 

In order to use the group policy-based software distribution, a group policy is created on the 
domain controller and assigned to the distributing software or published using Active Directory. 

● Assignment: The software distribution can be assigned to a user or a computer. In this 
case, the software to be distributed is automatically installed when the user logs in or the 
computer is started.

● Publication: The software distribution can be published for single users. In this case, when 
the user logs onto the client computer, the software to be distributed appears in a dialog 
and can be selected for installation.
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Installation without user interaction
During installation of the Web client, the user is normally prompted to enter information, such 
as the target directory, agreement to the software license conditions or components to be 
installed. By implementing a configuration file, installation is possible without user interaction. 
The required path specification and user information are provided in the "options.ini" 
configuration file. The file must be in the same folder as the web client setup.          ‌
 This installation procedure is advantageous when using the group policy-based software 
distribution. 

Installation from the product DVD occurs with user interaction. 

The settings predefined in the table are used under the following conditions: 

● The "options.ini" configuration file is missing and there is no corresponding entry available 
in the client registry, e.g. due to another SIMATIC HMI product installed.

● Alternatively, the installation is performed via the group policy based software distribution 
with assignment to the computer.

Information Parameters

Target directory for the Web Navigator client INSTALLDIR=" <syspath1>\Siemens\WinCC"
Target directory for common components COMMONDIR=" <syspath2>\Siemens "
User information / user name USER
User information / organization COMPANYNAME

The "<syspath?>" parameters result from the settings in the registry under the key 
"HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion" :

 - "<syspath1>" corresponds to the key "ProgramFilesDir" e.g. "C:\\Program Files"

 - "<syspath2>" corresponds to the key "CommonFilesDir", e.g. "C:\\Program Files\\Common 
Files"

Example of a "options.ini" configuration file
 
[USERINFO]
USER=Integration 
COMPANYNAME=Siemens AG
 
[INSTALLPATH]
COMMONDIR=" C:\Programs\Common files\Siemens " 
INSTALLDIR=" C:\Programs\Siemens\WinCC "
 
[FEATURES]
FUNCTIONTRENDCONTROL=0
HARDCOPY=0

WinCC/WebNavigator Installation Notes
1.5 Installation of the WinCC/Web Navigator Client

MDM - WinCC/WebNavigator
22 System Manual, 11/2008,  



WINCCUSERARCHIVES=0
DEU=0
FRA=0
ITA=0
ESP=0

1.5.3 Internet Explorer Settings

Introduction
In order to have the full functionality available on the Web Navigator Client, the security settings 
must be adapted in the Internet Explorer. 

Procedure
● Click "Tools" > "Internet Options" in the Internet Explorer.

● Select the "Security" tab. Select the corresponding zone, e.g. "Local Intranet" or "Internet".
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● Click "Custom Level".

● Click the "Enable" radio buttons for "Script ActiveX controls marked safe for scripting" and 
"Download signed ActiveX controls".

● Select the "Activate" option under "Scripting/Active Scripting".

● Click "OK". Carry out the modifications in the subsequent dialog.

● Select the "Trusted Sites" icon and click the "Sites" button to open the "Trusted Sites" dialog.

● Enter the address of the web server in the "Add this Website to the zone" field. Possible 
formats and wildcards include "*://157.54.100 - 200", "ftp://157.54.23.41", or "http://
*.microsoft.com". Deactivate the "Require server verification (https:) for all sites in this zone" 
check box. check box. Click "Add". Confirm the entry by clicking "OK".

● Select the "Trusted Sites" icon. Click the "Standard level" button and then the "Custom 
Level" button. Activate the "Activate" option in the "Security settings" dialog under "Initialize 
and script ActiveX controls not marked as safe". Confirm the entry by clicking "OK".

● Click on the "General" tab. Click in the "Settings" area on the "Temporary Internet Files" 
button. Enable the "Automatic" option under "Check for newer versions of stored pages". 
Confirm the entry by clicking "OK". 

● Close the "Internet Options" dialog by clicking "OK".

This completes all necessary settings in the Internet Explorer.
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1.5.4 Installation from the DVD

Requirements
● For the installation and use of the WinCC/WebNavigator client, see the settings described 

in "Settings in Internet Explorer."

● Depending on the operating system, certain minimum user rights are required for the 
installation of the Web client as described in the section "Installation of the WinCC/
WebNavigator Client."

Proceed as follows
1. Insert the WinCC DVD in the drive.

The DVD starts automatically if Autorun is enabled in the operating system. If the Autorun 
function is not activated, start the program Setup.exe on the DVD.

2. In the "Installation Type" dialog, select "Package Installation".

3. Select the "WebNavigator Client" program package.

4. Restart the installation.
You can track the status of the installation in the displayed dialog. Select "Cancel" to cancel 
the installation.

5. At the end of the installation process, the security settings that are adapted for WinCC are 
displayed in the "SIMATIC Security Control" dialog. The firewall is configured automatically.
Confirm the changes with "Accept" and "Finish".

6. Restart the computer when prompted to do so by setup.
The WinCC/WebNavigator client is installed and has been added as a function in the 
navigation window of the WinCC Explorer.

1.5.5 Installation via the Intranet/Internet

Requirements
● For the installation and use of the WebNavigator Client, the settings described in "Settings 

in Internet Explorer" apply.

● Depending on your operating system, certain minimum user rights may be required to install 
and initially register the web client, as described in the section "Installation of the 
WebNavigator Client".

● For installation via the Intranet/Internet, you must have fully installed your WinCC/
WebNavigator Server, configured the Internet information with the WinCC Web 
Configurator and be registered as a user in the WinCC User Administrator.

● A WinCC project must be in runtime on the desired WebNavigator Server.
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Installing WebNavigator Client via the Intranet/Internet
● Access the Internet via your Internet Service Provider.

● Enter the address of the WinCC/WebNavigator Server, e.g. "http://www.server_name.de", 
in the address line. When installing in a virtual directory, the address can be as follows: 
"http://www.server_name.de/WebNavigator/".

● Log on to the WinCC/WebNavigator Server with your user name and password.

● If you are accessing the WinCC/WebNavigator Server for the first time, you will be prompted 
to install the WinCC/WebNavigator Client. Click the "Click here to install" link. Click the 
"Save" button in the "File Download" dialog to store the client setup on the target computer. 
It is recommended to save the Setup file because, in the event of a restart of the client 
computer being necessary, the Setup need not be downloaded again.

Note

If you have already installed the WebNavigator Client and wish to install a current version 
of the client via the Intranet/Internet, open the Client Setup straight away without saving 
the installation file on the target computer. If you want to save the new installation file, 
uninstall the old installation file first or save the new version of the file in different directory 
than the older version of the file.

● Leave the Internet Explorer open and open Windows Explorer. Navigate to the folder in 
which the Setup file was saved and start the Setup file by double-clicking it.

● Follow the instructions on the screen and enter the information and settings necessary. 
The client-side controls of the Web Navigator is installed. Close the Setup dialog.

When the installation is completed successfully, the client switches to the WinCC project 
currently in Runtime. 

1.6 WinCC/WebNavigator Diagnostics Client

1.6.1 WinCC/WebNavigator Diagnostics Client

Introduction
With the WebNavigator Diagnostics Client from WinCC, you can obtain low-cost access to 
many WebNavigator Servers. Multiple Diagnose Clients and regular clients can be run at the 
same time. During this process, no WebNavigator Server licenses are required, for licensing 
takes place on the Diagnostics Client.

Possible applications:
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● Remote maintenance: With the Diagnose Client, different WinCC systems are accessed 
for service and maintenance purposes.

● Central Control Room: With the Diagnose Client, multiple servers can be accessed 
simultaneously.

1.6.2 Diagnose Client Licensing

WinCC/WebNavigator Diagnostics Client
A "Diagnostics Client" license is required on the client computer.

The Diagnose Client can access up to 12 web servers simultaneously. 

If a license for WebNavigator Server or for WebNavigator Diagnostics Server is installed on 
the server, the Diagnostics Client also has access if the maximum number of clients is 
exceeded (guaranteed access).

WinCC/WebNavigator Diagnostics Server
This license allows a WebNavigator Diagnostics Client access to the web server. This license 
is required if no web server license for "regular" web clients is installed on the web server, but 
access via Diagnose Clients still is to be possible.
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In total, the simultaneous access of up to 50 Diagnose Clients per server is permitted. 

Note

If one of the required licenses is missing on the participating computers or a "regular" web 
client instead of a Diagnose Client is installed on the client computer, a message is displayed 
and the web Client runs in demo mode. 

If the Diagnose Client is installed without the respective license, a message concerning the 
missing license appears about one hour after each start of the computer. To eliminate this 
message, you can install a Diagnose Client license or definitely deinstall the Diagnose Client 
software.

Note

When a Diagnose Client must be installed on a computer with the WinCC basis system, the 
Diagnose Client must be reinstalled after uninstallation of WinCC.

 

You can find further information about licenses for WebNavigator Server and Client in the 
section "Requirements > Licenses".

See also
Licensing (Page 10)

1.6.3 Installation of the WinCC/WebNavigator Diagnostics Client

Introduction
The software for the WebNavigator Diagnostics Client is installed from the DVD on the client 
computer.

Requirements
● To do this, you must have administrator rights.

Proceed as follows
1. Insert the WinCC DVD in the drive.

The DVD starts automatically if Autorun is enabled in the operating system. If the Autorun 
function is not activated, start the program Setup.exe on the DVD.

2. In the "Installation Type" dialog, select "Custom Installation".

3. Select the "Diagnose Client" program in the Web Navigator" program group.
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4. Restart the installation.
You can track the status of the installation in the displayed dialog. Select "Cancel" to cancel 
the installation.

5. At the end of the installation process, the security settings that are adapted for WinCC are 
displayed in the "SIMATIC Security Control" dialog. The firewall is configured automatically.
Confirm the changes with "Accept" and "Finish".

6. Restart the computer when prompted to do so by setup.
WinCC/WebNavigator Diagnostics Client is installed.

1.7 WebNavigator Demo Project

Introduction
The WinCC DVD contains a WinCC Demo project as a self-extracting ZIP file 
"Web_Demo_Projekt.exe" in the "Samples\WebNavigator" directory. To install the project, 
copy the file in a local target directory and start the decompressing process by double-clicking 
the file. 

The following logins are already configured in the demo project:

WinCC Login Password

WebNavigator German winccd winccpass
WebNavigator English wincce winccpass
WebNavigator French winccf winccpass
WebNavigator Italian wincci winccpass
WebNavigator Spanish winccs winccpass
Terminal PocketPC PocketPC winccpass
Terminal Mobic Mobic winccpass
Terminal MP370 MP370 winccpass

1.8 Uninstallation
You can uninstall the WinCC/WebNavigator Server and WinCC/WebNavigator Client in the 
usual way, as in Windows.

● Open the "Control Panel" and double-click the "Add or Remove Programs" symbol.

● Click the "Change or Remove Programs" icon.

● Select the WebNavigator Server or Client and click "Remove". Follow the instructions on 
the screen.

The WinCC/WebNavigator Server/Client has now been removed from your system.
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Note

If you uninstall the WinCC/WebNavigator Server, you should also uninstall the associated 
authorization with the "Automation License Manager" program. This authorization may be 
reactivated later on. Additional information on the topic of authorization may be found in 
WinCC Software Protection. 
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WinCC/WebNavigator Release Notes 2
2 Resources

2.1 Release notes

Contents
These release notes contain important instructions.

The statements in these release notes are more binding than the instructions in the manuals 
and in the online help.

Please read these release notes carefully as they contain useful information.

2.2 Installation of software

Installation and Configuration

CAUTION

WinCC WebNavigator Version 7.0 SP1 is released only on the basis of WinCC V7.0 SP1.

The WebNavigator-Server/-Client Version V7.0 SP1 is not to be installed on a computer with 
WinCC versions lower than V7.0 SP1. Likewise, a version of WebNavigator Server/Client 
older than V7.0 SP1 must not be installed on a PC with WinCC Version 7.0 SP1.

Note that mixed use of European and Asian versions of WinCC and WebNavigator is not 
permitted in the configuration either.
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2.3 Information about WebNavigator

Communication Using Proxy Server
For communication using a proxy server, the following items should be observed.

● In a proxy server operation, the Web client should be a member of the server domain.

● Login process on proxy server with NTLM authentication: If the user logged onto the Web 
client has no access to this proxy server, there will first appear a login dialog window for 
the proxy server, then the login dialog for the WinCC user, and then again a login dialog 
for the proxy server.

WebNavigator Client Security Limitations

CAUTION

When using the WebNavigator client, Internet-specific security limitations must be observed. 
The WebNavigator client may take significantly longer (>20 seconds) than a regular WinCC 
client to recognize that the Web server is down or that the communication is faulty.

Internet Explorer Security Settings
In order to have the full functionality available on the WebNavigator Client, the security settings 
must be adapted in the Internet Explorer. Please refer to the chapter "WinCC/WebNavigator 
Installation Notes > Installing the WinCC/WebNavigator Client > Internet Explorer Settings." 

Internet Explorer Security Settings: Installation via SSL connection
If you want to download the WebNavigator from an ASP portal via an SSL connection, note 
that the download is not possible under certain conditions. You can correct this with one of the 
following settings:

● Deactivate the "Do not save encrypted pages to disk" option in the "Advanced" tab for the 
Internet options of the Internet Explorer.

● Deactivate the "Internet Explorer Enhanced Security Configuration" option in the "Control 
Panel/Add/Remove Programs/Windows Components".

WebNavigator server on Windows Vista: Behavior at restart
The standard website will be activated after restart in case of a WebNavigator server on 
Windows Vista. The connection from Web client to WebNavigator server will no longer be 
possible.

Solution: Restart the WebNavigator site in the Internet Information Service (IIS).

WinCC uninstallation: WebNavigator Client must be installed at a later time
If you uninstall WinCC, you need to retro-install the WebNavigator client.
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Deactivation of WinCC and WebNavigator Runtime
If you have deactivated WinCC Runtime, you must take into consideration during reactivation 
of WinCC Runtime that WebNavigator Runtime has already been terminated.

Project Change
Following a change of projects, a sporadic inoperable period of the Internet Information 
Services (IIS) may occur. The computer must then be restarted.

WebNavigator client: Operation via Wireless LAN
Operation of the WebNavigator client via Wireless LAN has been approved with SIMATIC 
Mobile Panel PC 12" only.

WebNavigator client: Picture Window on the Web Client
If the picture name is changed in a picture window, the event "Object Change" of this picture 
window is executed several times on the Web client while it occurs only once in the WinCC 
Basic System. This feature of the Web client is system related because the asynchronous 
procedure of the Internet connection may trigger a multiple update of the picture window object. 
However, this does not have any effect on functionality. 

WebNavigator client: WinCC Alarm Control on a WebNavigator Server in WinCC ServiceMode

Initial Situation
The WebNavigator client is connected with a WeNavigator server operated in WinCC 
ServiceMode.

Behavior
If you are using WinCC Alarm Control prior to WinCC V7 that is connected via a server prefix, 
you will not be able to open the selection dialog.

Solution
Use the WinCC AlarmControl that is offered as of WinCC V7.
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WebNavigator client: WinCC Web Browser-OCX on the Web Client
● The "Allow ActiveX Controls" check box has to be activated in the "Security" tab in the 

Internet options of the Internet Explorer.

● If a process picture is displayed on the Web client by using ActiveX Control "WinCC Web 
Browser", and a link is selected in same, the "Back" button will not work during the initial 
display of the linked page. Only upon the second call to this page will the function work 
properly. After a switch of the process picture, the original behavior is back.

● WinCC Web browser OCX serves to display static Web content or CHM documents in 
process pictures. Contents with scripting functionality are not supported.

WebNavigator client: Diagnostics file "WebNavReconnnect.log"
After installation of the Web client, the diagnostics file "WebNavReconnnect.log" will be saved 
in the "<User>\Application Data\Siemens\SIMATIC.WinCC\WebNavigator\Client" directory. 
The diagnostics file will be saved into the respective user profile so that this user no longer 
requires administrator rights. Under Windows Vista the directory will be available under 
"LocalLow".

WebNavigator Client V7.0 SP1: Connection with WebNavigator Server V6.2 SP2 or earlier under 
Windows Vista SP1

To connect a Web Navigator client V7.0 SP1 with a Web Navigator server V6.2 SP2 or later 
under Windows Vista SP1, you need to disable the "UAC - User Account Control" for the Web 
Navigator Client V7.0 SP1 or disable "Protected Mode" in the Internet Explorer.

WebNavigator client: Contents of Address Bar
During operation of the Web Client, character strings appear in the address bar of Internet 
Explorer that are neither relevant nor interpretable for the operator. For example, the entry 
"loadbalancing=no" may appear which does not represent any status display for servers 
involved in load balancing.          ‌
Only when logging in the Web client, characters must be entered and checked there, e.g. 
server name and port.

WebNavigator client: Client with multiple power users
When a power user installs a new WebNavigator client version on a computer, then all other 
power users of this computer must upgrade to the new version.

There can be problems if other power users use different versions. This is also applicable when 
the power users on one server connect to an older WebNavigator version.

WebNavigator client: Login Using Direct Entry into Address List
The use of Microsoft security patches for Internet Explorer V6 no longer permits registration 
of Web clients by entering user name and password in the address list. 
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WebNavigator client: "AutoComplete" Entries and Links in Progress Bar
In Internet Explorer, the entries in the address bar are displayed as a link in the progress bar, 
or suggested as "AutoComplete" entries for subsequent entries in the address bar. Upon 
registration of Web clients on Web servers with load balancing, these assists of Internet 
Explorer are not applicable without checking. 

If the Web client was initially registered on a Web server with load balancing and forwarded 
to a second Web server, the progress bar or "AutoComplete" entry of Internet Explorer will not 
display the address of the first Web server but instead the address of the second Web server 
to which the client was forwarded. If during subsequent registration attempts of the Web client, 
the link of the progress bar or the "AutoComplete" entry are accepted unchecked, this Web 
client will be registered on the second Web server. 

WebNavigator client: Uninstallation of the Software ProTool/Pro
If the ProTool/Pro software is uninstalled on a WebNavigator client, the HMI Symbol Library 
controls are deregistered. 

Reinstall the WinCC WebNavigator client to regain access to these controls.

WebNavigator client: Automatic Reconnect not Successful
If the connection between Web client and Web server is established through a firewall or a 
proxy server, it may happen that while normal registration of the Web client is successful, the 
automatic reconnect is not. The cause may be that the Web client uses the ICMP ping during 
reconnect which may be blocked by the firewall or proxy server. In case of this type of error, 
the use of the ICMP ping during reconnect can be deactivated on the Web client. 

You can find the "Deactivate ICMP ping" option at the client ASP end under "Settings/
Properties Web Client / Reconnect".

WebNavigator client: WinCC Computer with "Basic Process Control"
When using the WebNavigator client with a WinCC computer with WinCC Basic Process 
Control, the plug-in "WinCC Basic Process Control" must be installed on the Web client. 
Without plug-in, the functionality of WinCC Basic Process Control is not available on the Web 
client, for example, the respective ActiveX Controls as well as group display are missing.

The plug-in is located in the directory "<wincc_installation_path>\WebNavigator\Server\Web
\Install\Custom" on the Web server and can be downloaded in the WebNavigator interface in 
the download area under "Download Plug-Ins".

A description of supported and non-supported functions may be found in WinCC Information 
System under "Options > Options for Process Control > System Overview Process Control 
System Options > Configuration in PCS7 Environment > Web Client" as well as under "Release 
Notes > Process Control System Options".

If the WebNavigator client is to be installed on a dedicated Web server with WinCC Basic 
Process Control, the plug-in "WinCC Basic Process Control" must be installed immediately 
after installation of the Web client. The download page for the plug-in will be displayed and 
can be exited only upon installation of plug-ins for process picture display.

For more information on supported functionalities of the WebNavigator client during a 
connection to a PCS7 OS, refer to the PCS7 documentation.  
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WebNavigator client: "FLAG_COMMENT_DIALOG" of the "GCreateMyOperationMsg" function
The Web Client does not support parameter "FLAG_COMMENT_DIALOG" for the 
"GCreateMyOperationMsg" function.

Custom ActiveX controls (Industrial X)
With custom ActiveX controls (Industrial X), compatibility with WinCC Basic System, Web 
Navigator Server and Web Navigator Client must be ensured. This applies to both a direct 
installation of ActiveX Control on the computer with WinCC, Web server or Web client and the 
installation using a plug-in, such as on a Web client. 

● With a direct installation, the ActiveX Control should therefore be installed prior to WinCC 
Basic System, Web Server or Web Client. If the custom ActiveX Controls do not function 
without error after this step, there is no compatibility.  

● If the custom ActiveX Control was packaged in a plug-in and installed via download, an 
upgrade of WinCC Basic System, Web Server or Web Client will also require generation 
of a new plug-in using this ActiveX Control. When creating the plug-in, care should be taken 
to use compatible binaries (DLL, OCX, etc.).

WebNavigator Web page under Windows XP
Under Windows XP Professional it is not possible to delete a stand-alone Web page containing 
"Internet Information Service" (IIS) functions. If a stand-alone Web page was created on the 
Web server using the Web Configurator, it cannot be deleted in order to create the 
WebNavigator Web page as a virtual directory instead.          ‌
Also, only one Web page can be active under Windows XP Professional, even if a different 
port has been assigned to every Web page. If the default Web page is needed, the stand-alone 
WebNavigator Web page cannot be active at the same time. 

With the following command line call you may, however, delete the stand-alone WebNavigator 
Web page. Exit the console of IIS prior to calling this command line.

"<wincc_installation_path>\WebNavigator\Server\bin\WinCCWebConfigurator.exe" 
deinstall="yes"  

Afterwards, in the IIS console, start the desired Web page, such as the default Web page. 

Access of Web Client to a WinCC flexible Sm@rt Service Server
If a WebNavigator client is supposed to access a WinCC flexible Sm@rt Service server, this 
may be facilitated in the Web Navigation interface using the "Change Server" function, as with 
any other WinCC WebNavigator server.

SIMATIC Logon 
WebNavigator V7.0 SP1 supports SIMATIC Logon V1.4 SP1. 

The following restrictions apply.
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● If the operator is a member of multiple user groups, a random group that has a start picture 
configured is chosen. You cannot configure which group is chosen. The authorizations of 
all groups in which the operator is a member are summarized.

● The domain must be placed before the user name in the login dialog: Syntax "<domain>
\<username>".

● If the password expires during a client session, this does not affect the operatability of the 
Web client.

● The password can only be modified on the Web server. It is not possible to change the 
password on a Web client.

● Scripts and ODK functions are not supported for SIMATIC Logon.

2.4 Service and Support

2.4.1 Warnings

Safety notes
This manual contains information that must be observed to ensure your personal safety and 
to prevent property damage. Notices referring to your personal safety are highlighted in the 
manual by a safety alert symbol; notices referring to property damage only have no safety alert 
symbol. Depending on the hazard level, warnings are displayed in a descending order as 
follows:

DANGER

means that there can be severe physical injury or even death if the corresponding safety 
measures are not followed.

WARNING

means that there can be severe physical injury or even death if the corresponding safety 
measures are not followed.

CAUTION

means that there can be slight physical injury if the corresponding safety measures are not 
followed.

WinCC/WebNavigator Release Notes
2.4 Service and Support

MDM - WinCC/WebNavigator
System Manual, 11/2008,  37



CAUTION

means that there can be damage to property if the corresponding safety measures are not 
followed.

NOTICE

means an undesirable result or state can occur if the corresponding instruction is not followed.

Note

is an important information about the product, the way to handle the product or the respective 
part of the documentation and we wish to especially bring this to your notice.

If multiple levels of hazards can occur, the warning is always displayed with the highest possible 
level. If a warning with a warning triangle is to be indicate physical injury, the same warning 
may also contain information about damage to property.

Qualified Personnel
The corresponding machine/ system may only be set up and operated with the help of this 
documentation. A device/system must only be commissioned and operated by qualified 
personnel. Qualified persons in the sense of safety instructions in this documentation stand 
for persons who are authorized to operate, earth and mark machines, system and electrical 
circuits according to safety standards.

Proper use
Please observe the following:

WARNING

The machine may only be used for the application instances that have been described in the 
technical description and only in combination with third-party devices and components 
recommended and/or approved by Siemens. Smooth and safe operations demand proper 
transport, proper storage, installation and assembling as well as careful operations and 
maintenance.

Brands
All designations with the trademark symbol ® are registered trademarks of Siemens AG. Other 
designations in this documentation may be trademarks whose use by third parties for their own 
purposes can violate the rights of the owner.
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Disclaimer of liability
We have checked the contents of the description to ensure that it matches with the hardware 
and the software it describes. Nevertheless, we cannot assume responsibility for any 
deviations that may arise. The details outlined in this description are checked regularly and 
the required corrections are done in the subsequent editions. Suggestions for improvement 
are welcomed.

The statements in the online documentation are more binding than the statements in the 
manuals and PDF files.

Please follow the Release Notes and Installation Notes. The information in these Release 
Notes and Installation Notes has priority over that in the manuals and online help with regard 
to legal validity.

Copyright © Siemens AG 2008
Änderungen vorbehalten / All rights reserved

It is prohibited to transfer, copy, evaluate or communicate this document in full or part unless 
the same has been explicitly approved. Violation of this rule can lead to claims for damage 
compensation. All rights reserved, especially for granting patents or for GM registration.

Siemens AG

Automation and Drives

SIMATIC Human Machine Interfaces

P.O. Box 4848

D-90327 Nuremberg, Germany

2.4.2 Customer Support

Customer Support and Technical Support
Accessible from anywhere in the world - at any time! The languages used by the SIMATIC 
hotlines are German and English. Authorization hotline support is also available in French, 
Italian and Spanish.

Technical support

Nuremb
erg

(GMT +1:00)

Service 
Hours

Monday - Friday, 7:00 to 17:00 (Local Time)

Phone +49 (180) 5050-222 (0.14 €/min from German 
landlines),          ‌
cell phone prices vary.
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Fax +49 (180) 5050-223
E-mail http://www.siemens.com/automation/support-request (http://www.siemens.com/

automation/support-request)

SIMATIC Customer Support Online Services

SIMATIC Products
Go to the following URL for additional information about SIMATIC products:

● http://www.siemens.de/simatic (http://www.siemens.com/simatic)

Product Information and Downloads
You can get the latest product information and downloads useful for your application on the 
Internet at the following URL or on the Bulletin Board System:

● http://www.siemens.de/automation/service&support (http://
support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo2&aktprim=99&lang=en)

Contact person database
To contact your local agent, search our contact database at the following URL:

● http://www.automation.siemens.com/partner/index.asp (http://
www.automation.siemens.com/partner/index.asp?lang=en)

Technical documentation for SIMATIC products
You can find a guide to the technical documentation provided for individual SIMATIC products 
and systems at the following URL:

● http://www.siemens.de/simatic-tech-doku-portal (http://www.automation.siemens.com/
simatic/portal/html_76/techdoku.htm)

● http://www.siemens.com/simatic-tech-doku-portal (http://www.siemens.com/simatic-tech-
doku-portal) (in English)

Up-to-Date Information for WinCC

SIMATIC WinCC
Go to the following URL for additional information about WinCC products:

● http://www.siemens.de/wincc (http://www.automation.siemens.com/hmi/html_76/products/
software/wincc/index.htm)

● http://www.siemens.com/wincc (http://www.siemens.com/wincc) (in English)
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WinCC Online Support and FAQs
WinCC Online Support with information on FAQs (Frequently Asked Questions) and 
replacement parts as well as Tips & tricks may also be found in the Internet under :

● http://support.automation.siemens.com/WW/view/de/10805548/133000 (http://
support.automation.siemens.com/WW/view/en/10805548/133000)

● http://www.siemens.com/automation/csi/faq (http://www.siemens.de/automation/csi/faq)

There, you find for example downloads of firmware updates, service packs and useful utilities.

See also
Technical Support: E-mail (http://www.siemens.com/automation/support-request)

Internet: SIMATIC Products (http://www.siemens.com/simatic)

Internet: Product Information and Downloads (http://support.automation.siemens.com/WW/
llisapi.dll?func=cslib.csinfo2&aktprim=99&lang=en)

Internet: Contact person database (http://www.automation.siemens.com/partner/index.asp?
lang=en)

Internet: Technical documentation for SIMATIC products (http://
www.automation.siemens.com/simatic/portal/html_76/techdoku.htm)

Internet: Information about WinCC (http://www.automation.siemens.com/hmi/html_76/
products/software/wincc/index.htm)

Internet: WinCC Online Support  (http://support.automation.siemens.com/WW/view/en/
10805548/133000)

Internet: WinCC FAQs (http://www.siemens.de/automation/csi/faq)

Internet (English): Technical documentation for SIMATIC products (http://www.siemens.com/
simatic-tech-doku-portal)

Internet (English): Information about WinCC (http://www.siemens.com/wincc)

2.4.3 Support Request
Dear customer

In order to provide you with fast and effective support, please complete the error report online 
on the Internet. Describe the problem in as much detail as possible. We would appreciate if 
you would provide us with all project data, so that we can reproduce the error situation or 
shorten the turn-around time.

Before filling out the error report, check whether your configured quantity structure is within 
the range of tested quantity structures (see topic "Performance Data").
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Form for the error report
The error report form is available at URL:

● http://www.siemens.com/automation/support-request (http://www.siemens.com/
automation/support-request) 

When filling out the report, you will be guided through several steps, which will ask about all 
required information.

Procedure
1. Open the "Support Request" form using the link on the Internet. Step 1 "Select product" is 

displayed:

2. Enter the project name in the "Product/Order number" box. Upper/lower case is not relevant.
Search for parts of the product name or enter the full product name in the correct order. 
You can e. g. search for the following terms:
- "WinCC Runtime"
- "WinCC DataMonitor"
- "wincc webnavigator"
- "Connectivity"
The found products are offered in the "Product selection" field. 

3. Select the desired product and click on "Next" to switch to step 2 "Select use case".

4. Select a use case or describe your specific use case in the "Other use case" field.

5. Press "Next" to switch to step 3 "Our solutions".
Suggested solutions and FAQs for the selected key words are listed. The search terms in 
the "Your search term" field can be modified in any manner.
Once you have found a suggested solution for your problem, you can close the form in the 
browser.
If you did not find any applicable suggested solutions, press "Next" to switch to step 4 
"Describe problem".

6. Describe your problem as exactly as possible in the "Details" field.
Pay particular attention to the following questions and comments. Please also check the 
WinCC installation and configuration with regard to the following references.
If you have any idea what has caused the error, please let us know. No detail should be 
omitted, even if you consider it unimportant.
- Was the configuration data created with older WinCC versions?
- How can the error be reproduced?
- Are other programs running simultaneously with WinCC?
- Have you deactivated the screen saver, virus checker and power management function?
- Search the computer for log files (WinCC\Diagnose\*.log, drwatson.log, drwtsn32.log). 
The log files are needed for error analysis. Thus, be sure to send the log files as well.

7. Use the "Search" button to upload your affected project and the log files (e. g. as a Zip file) 
to the error report.
Press "Next" to switch to step 5 "Provide contact information".
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8. Enter your contact information.
Read the privacy notice and choose whether your personal data should be permanently 
saved.
Press "Next" to switch to step 6 "Summary & Send".

9. Press the "Print" button if you would like to print the error report.
Close the error report by clicking on the "Send" button.
Your data will be transmitted to Customer Support and processed there.

Thank you for your cooperation. We hope that we can be of assistance in solving your problems.

Your WinCC Team 

See also
Error report (http://www.siemens.com/automation/support-request)

2.4.4 Support

Inquiries on Operation and Problems
In case problems occur during operation, you may contact us directly.

To contact your local agent for Automation & Drives, search our contact database at the 
following URL:

● http://www.automation.siemens.com/partner/index.asp (http://
www.automation.siemens.com/partner/index.asp)

Please have available the Software Identification Number from the supplied software product 
certificate.

In case of lost or defective authorizations, a telephone "repair" may be performed by our 
Customer Support.

You can find additional information on contacts under "Customer Support". 

Internet / World Wide Web (WWW)
You can find general information on WinCC in the Internet at:

● http://www.siemens.de/wincc

You can find a demo project for the WebNavigator at: http://wincc.de.

You can find additional information for users (FAQs / Tips and Tricks) at:

● http://www.siemens.de/automation/service&support
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See also
Internet: Contact person database (http://www.automation.siemens.com/partner/index.asp)
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WinCC/WebNavigator Getting Started 3
3 Resources

3.1 WebNavigator - Getting Started

Contents
The WinCC option pack "WinCC Web Navigator" enables you to develop a solution for the 
topic of "Controlling and Monitoring" via the intranet/Internet. You can therefore use standard 
means of WinCC to quickly and easily implement the distribution of controlling and monitoring 
functions of your automation system via the Internet and intranet. The "WinCC Web Navigator" 
supports current Internet security methods and provides Wizards to assist you in your task. 

This section shows you:

● how to install the WinCC Web Navigator 

● how to set up the Web Navigator Server 

● how to configure and start the first Web project
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3.2 Introduction
Welcome to the WinCC Web Navigator.

WinCC is the first IHMI (Integrated Human Machine Interface) software on the market that truly 
integrates your system control software with your automation process. The user-friendly 
components of WinCC make the integration to new or existing applications trouble-free.

The Web Navigator package consists of special WinCC Web Navigator Server components 
that are installed on the server computer, and of WinCC Web Navigator Client components 
that run on the Internet computer.

The pictures displayed on the WinCC Web Navigator Client can be controlled just like in a 
normal WinCC system. In this way, the project running on the server computer can be 
controlled from anywhere in the world. 

3.3 Installation Overview

Installation Overview
The following requirements must be met for installation:

● A released Windows operating system has been installed.

● WinCC Basic is installed.

More information on Hardware and Software prerequisites for the WebNavigator can be found 
under the "WinCC Web Navigator - Documentation > Prerequisites > Hardware and Software" 
topic.

Details of the WinCC installation may be found in the WinCC documentation. 

3.4 First Web Project

3.4.1 First Web Project
The chapter is based on the "WebDemoProject" project included on the WinCC DVD.

For this example project, the WinCC WebNavigator Server, WinCC, and WinCC WebNavigator 
Client are installed on the same computer. When making changes to the WinCC project, you 
are working with the server component (WinCC and WinCC WebNavigator Server). When 
accessing the project with Internet Explorer, you are working with the client component (WinCC 
WebNavigator Client).

The chapter describes the following steps:

● Configuring the WebNavigator Server

● Publishing of process pictures that can run on the WinCC WebNavigator Client

● User Administration
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● Internet Explorer Settings

● Installation of the WinCC WebNavigator Client

● Creation of a new process picture

See also
Step 11: Creating a New Process Picture (Page 72)

Step 9: Installation of the WinCC/Web Navigator Client (Page 66)

Step 8: Internet Explorer Settings (Page 64)

Step 7: WinCC User Administrator (Page 62)

Step 5: Starting the Web View Publisher (Page 56)

Step 1: Starting the "WebDemoProject" project. (Page 47)

3.4.2 Configuration of the WinCC/Web Navigator Server

3.4.2.1 Step 1: Starting the "WebDemoProject" project.
Copy the WinCC project "WebDemoProject" onto the hard drive of your computer from the 
WinCC DVD.

Follow the screen prompts. 

Start WinCC from the Windows start menu via "SIMATIC" > "WinCC" > "Windows Control 
Center".

Open the "WebDemoProject".

In the following dialog, click "Start server locally".

The project can only be activated, if your computer has been entered as an available server 
in the computer list.

In the project navigation window of the WinCC Explorer, right-click "Computer" and then 
select the "Properties..." menu command from the displayed shortcut menu.
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Click the "Properties" button to edit the properties of the selected computer.

In the "Computer Name" field, enter the name of your computer.

Click "OK."

The changes only take effect after the project is restarted.

Close the "WebDemoProject" via "File" > "Exit".

Reopen the "WebDemoProject".

To start Runtime, click "File" > "Activate" in the WinCC Explorer menu bar. A check-mark next 
to "Activate" indicates that Runtime is active.

Alternatively, you can use the "Activate" button on the toolbar of the WinCC Explorer.

See also
Step 2: WinCC Web Configurator (Page 48)

3.4.2.2 Step 2: WinCC Web Configurator

In the navigation window of the WinCC Explorer, right-click "Web Navigator".

 In the shortcut menu, click the "Web Configurator" option.

WinCC/WebNavigator Getting Started
3.4 First Web Project

MDM - WinCC/WebNavigator
48 System Manual, 11/2008,  



Click "Next".

See also
Step 3: Defining Standard Website (Page 50)
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3.4.2.3 Step 3: Defining Standard Website
When starting the WinCC Web Configurator for the first time, a dialog giving you two choices 
opens:

Select "Create a new standard website (Standalone)". Click "Next".
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As the name of the Web site, enter "WebNavigator". Select an IP address from the 
selection field.

Select "WebClient.asp" as the standard web site. Click "Next".

WinCC/WebNavigator Getting Started
3.4 First Web Project

MDM - WinCC/WebNavigator
System Manual, 11/2008,  51



Click "Windows-Firewall" to configure the firewall.
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Select "LAN connection" on the "Advanced" tab. Click "Settings".
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Activate "Webserver (HTTP)". Click "OK" to close the dialog box. Close the "Windows 
Firewall" dialog by clicking "OK".

Click "Finish" to complete the configuration.

See also
Step 4: Checking of Activated Website (Page 55)
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3.4.2.4 Step 4: Checking of Activated Website

Activate the Internet Information Service. To do this, select "Programs" > "Management" 
> "Internet Information Services".

 In the navigation window, select the computer.  In Windows XP, the subfolder "Websites" 
must also be selected. The data window displays the corresponding websites. Check the 
information displayed for the websites. If "Stopped" is displayed next to the desired website, 
e.g. "WebNavigator", the website needs to be started. To do this, right-click the website and 
select the "Start" menu command from the shortcut menu.

Close the dialog.

The website is now activated.

See also
Step 5: Starting the Web View Publisher (Page 56)
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3.4.3 Publishing Process Pictures

3.4.3.1 Step 5: Starting the Web View Publisher

In the navigation window of the WinCC Explorer, right-click "Web Navigator".

 In the shortcut menu, click the "Web View Publisher" option.

Click "Next".

See also
Step 6: Publishing Pictures (Page 57)
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3.4.3.2 Step 6: Publishing Pictures

The picture folder in the WinCC project and the folder for the Web access are generally 
set correctly.

Path to WinCC project 
folder:

...project path\ project name

Folder for web access: ...project path\ project name\WebNavigator

 

Click "Next".
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Click the ">>" button to select all files.

Click "Next" to go to the next dialog.
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Via ">", select the C Project Functions that are to be published.

Click "Next" to go to the next dialog.
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In this dialog, select the graphics referenced in the process pictures (*.PDL) that you want 
to publish (e.g. bitmaps). 

Click "Next" to go to the next dialog.
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Click "Finish" to publish the pictures on the website.
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After the completion, a dialog is displayed. Confirm it by clicking "OK". To complete the 
process, click "Finish".

See also
Step 7: WinCC User Administrator (Page 62)

3.4.3.3 Step 7: WinCC User Administrator

In the navigation window of the WinCC Explorer, right-click "User Administrator".

In the shortcut menu, select the "Open" menu command.
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Click  to create a new user.

Enter the necessary data in the "Establish New User" dialog.

Confirm your entries with "OK."

Highlight the desired user in the navigation window of the User Administrator.

Defining the Startup Picture

Select the "Web Navigator" check box in the table window. The "Web Options" area is 
displayed.  

Click the "..." button of the "Startup Picture" field.  
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In the following dialog, select the appropriate startup picture, e.g. " WinccPic.PDL", and 
click "OK".

Defining the Language

Click the "..." button of the "Language" field.

Select the appropriate language, e.g. "English (United States)" and click "OK".

Note

Only languages that have been installed in WinCC are available for selection.

 

Defining Rights

Highlight the desired user in the navigation window of the User Administrator.

In the table window, select the desired rights by double-clicking in the "Authorization" 
column.

Repeat these steps for each user.

See also
Step 8: Internet Explorer Settings (Page 64)

3.4.4 Client Access to the Web Project

3.4.4.1 Step 8: Internet Explorer Settings

Click "Tools" > "Internet Options" in the Internet Explorer.

Select the "Security" tab. Select the corresponding zone, e.g. "Local Intranet" or "Internet".
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Click "Custom Level".
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Click the "Enable" radio-buttons for "Script ActiveX controls marked safe for scripting" 
and "Download signed ActiveX controls".

Click "OK".

In the "Internet Option" dialog, click "Apply".

Click "OK".

This completes all necessary settings in the Internet Explorer. 

See also
Step 9: Installation of the WinCC/Web Navigator Client (Page 66)

3.4.4.2 Step 9: Installation of the WinCC/Web Navigator Client

In the address field of the Internet Explorer, enter the address of the WinCC Web 
Navigator Server, e.g. "http://<Name_of_the_Server>" and then press the ENTER key.

You are asked to enter your user name and password, e.g. Snoopy.
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Confirm your entry with "OK."

If you are accessing the WinCC Web Navigator Server for the first time, the following page is 
displayed:
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Click the "Click here to install" link to copy the program to your client computer.
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Click the "Save" button. In the next dialog, select the directory in which the Setup file of 
the Web Navigator Clients are to be saved.  

Leave the Internet Explorer open and open Windows Explorer. Navigate to the folder in 
which the Setup file was saved and start the Setup file by double-clicking it. 

The file is decompressed after and the setup of the Web Navigator Client is started.

Click "Next". 

Activate the "I accept the terms of the license agreement" in the "License Agreement" 
dialog. Click "Next". 

 Enter the user name and organization in the "User information" dialog. Select those for 
whom the application is installed, e.g. "Anyone who uses this computer (all users)". Click "Next".

Select the "Complete" option in the "Setup type" dialog to install the components of the 
Web Navigator Clients. Click "Next".

Click the "Install" button in the next dialog.

Click the "Finish" button in the "Install Wizard completed" dialog.

After the successful installation of the WinCC Web Navigator Client software, the client 
connects to the Runtime project.

Note

It is recommended to save the Setup file because, in the event of a restart of the client 
computer being necessary, the Setup need not be downloaded again.          ‌
If an error message appears during installation of the Web Navigator Clients and the process 
is canceled, check that the hardware and software conditions have been met by referring to 
the topic "Installation and Deinstallation" . 
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See also
Step 10: Web Project (Page 70)

3.4.4.3 Step 10: Web Project
The startup picture corresponding to the user identified is displayed.

In the case of the user "Snoopy", "WinccPic.pdl" was defined as the startup picture.

Confirm the dialog by clicking "OK".
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If you enter, for example, the value 50 in the input field, the fill level of the tank in the 
"WebDemoProject" changes accordingly.
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See also
Step 11: Creating a New Process Picture (Page 72)

3.4.5 New Process Picture

3.4.5.1 Step 11: Creating a New Process Picture

In the navigation window of the WinCC Explorer, click the "Graphics Designer" and then 
right-click the "WinccPic.pdl" picture in the data window.

 In the shortcut menu, click the "Open Picture" menu option.

WinCC/WebNavigator Getting Started
3.4 First Web Project

MDM - WinCC/WebNavigator
72 System Manual, 11/2008,  



Creating a Trend Window

From the object palette, select the "Controls" tab and from it the "WinCC Online Trend 
Control".

In the "General" tab of the quick configuration dialog, enter "FillLevelTrend" as the title of 
the trend window.

Select the "Trends" tab.

Enter "FillLevel" as the name of the trend.

Click the "Selection" button.
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On the right side of the "Selection of Archives/Tags" dialog, double-click the "FillLevelArchive". 

On the right side of the "Selection of Archives/Tags" dialog, click the "FillLevelArch" tag.

Confirm your inputs by clicking "OK".

Creating a Table Window

From the object palette, select the "Controls" tab and from it the "WinCC Online Table 
Control".

As the title of the table window, enter "FillLevelTable".

Repeat the steps performed for the "Trends" tab of the WinCC Online Trend Control in the 
"Columns" tab of the WinCC Online Table Control.

Confirm your entries by clicking "OK".

Creating an Alarm Message Window

From the object palette, select the "Controls" tab and from it the "WinCC Alarm Control".

In the quick configuration dialog, enter "Water Supply Atlanta" as the title of the message 
window.

Select the "Display" check box.

Confirm your entries by clicking "OK".

Save the picture under the name "WinccPic1.pdl" and exit the Graphics Designer.

See also
Step 12: Publishing Process Picture (Page 74)

3.4.5.2 Step 12: Publishing Process Picture

In the navigation window of the WinCC Explorer, right-click "Web Navigator".

 In the shortcut menu, click the "Web Configurator" option.

In the "Select Pictures" dialog, select "WinccPic1.pdl".

Click "Finish" to complete the operation.

Note

Each picture changed must again be converted using the "Web View Publisher".
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Open the "WinCC User Administrator" and, for example, set "WinccPic1.pdl" as the new startup 
picture for the user "Snoopy". Close the User Administrator again. 

The Project view can be updated using "View" > "Refresh" in WinCC Explorer.

See also
Step 13: Process Picture on Web Client (Page 75)

3.4.5.3 Step 13: Process Picture on Web Client
Start the Internet Explorer.

Log in, for example, using the user name "Snoopy" and its password.

Confirm the prompt with "OK".

If everything is configured correctly, you should see the following picture:
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Enter a new value in the input field.

The displays of the "WinCC Online Trend Control / Table Control" changes accordingly (as in 
the "WebDemoProject").
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Note

When using more complex functions or scripts in your project, please keep in mind the 
limitations, etc. outlined in the corresponding chapters of the WinCC Web Navigator 
documentation. 

See also
Troubleshooting (Page 77)

3.5 Troubleshooting

No pictures are displayed
On the WinCC Web Navigator Server computer, check whether the "WebNavigator" Website 
is active:

● Activate the Internet Information Service via "Programs" > "Management" > "Internet 
Information Services". Check the information at "WebNavigator". If "Stopped" is displayed, 
the Website needs to be started. To do so, right-click "WebNavigator" and select the "Start" 
menu command from the shortcut menu.

Startup picture is not updated
The startup picture displayed by the Internet Explorer does not match the picture you have 
just edited, since the Internet Explorer has saved the previous startup picture to its temporary 
storage. 

● Start the Web View Publisher in order to make the new picture available on the Internet.

● Delete the temporary Internet files in the Internet Explorer via "Tools" > "Internet Options".
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WinCC/WebNavigator Documentation 4
4 Resources

4.1 Function Overview

Introduction
The enormous growth of the Internet in recent years has had and is having a large impact on 
industrial development. One of the key factors responsible for the Internet boom was the 
development of the World Wide Web WWW Internet service.

Browser applications with graphical user interfaces make accessing and navigating the Web 
easy: clicking a mouse button is all that is needed to cross geographical borders.

The WinCC WebNavigator option package to the WinCC basic system enables you to develop 
a solution for controlling and monitoring processes via the Intranet/Internet. With this option 
package and the standard tools of WinCC, a new way of distributing the HMI functions of your 
plant - employing the Intranet/Internet - can be implemented. The WinCC Web Navigator 
supports current Internet security methods and provides Wizards to assist you in your task.

The communication mechanisms of the WinCC Web Navigator utilize a powerful and optimized 
event-driven transmission of data that delivers the best performance via the Intranet/Internet.

The WinCC WebNavigator user interface combines various Web functions and makes them 
available to the user in a clear format. The contents of the navigation interface can be expanded 
by the user. Installed DataMonitor components are also displayed by the navigation interface. 

The WinCC WebNavigator package consists of special server components that are installed 
on the server computer and of client components that are installed on the client computer on 
the Intranet/Internet.
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As a so-called "thin client", the WinCC Web client can control and monitor a running WinCC 
project from an opened Internet Browser, without the need of having to install the complete 
WinCC basic system on the client computer.

The WinCC Web Navigator thus cost-effectively expands the networking of client-server 
systems to the intranet/Internet. The project and the associated WinCC application are located 
on a server computer. This provides a clear separation of the visualization components on the 
client computer and the WinCC project running on the server computer. This means that 
operator stations can be set up easily, e.g. for maintenance or diagnostics purposes.

The software of the WinCC Web Navigator Client can be installed in various ways: As usual 
using DVD as a self-decompressing file via the Intranet/Internet or even via a group guideline 
based software distribution in networks. If the client component is missing during direct access 
to WinCC WebNavigator Server, the operator is prompted automatically to load the file to his 
computer. This scenario provides the WinCC WebNavigator operator with a high degree of 
flexibility and mobility.

A property of the user administration is the user-specific assignment of the startup picture and 
the language. For every user, a different startup picture and language can be set. By assigning 
user authorizations, a scalable access to different project areas and functions can be 
implemented for the various users.

The pictures displayed on the WinCC Web Navigator Client can be controlled as in a normal 
WinCC system, provided the user possesses the necessary user authorizations. In this way, 
the WinCC project running on the server computer can be controlled from anywhere on earth. 
The Web client supports pan, zoom and declutter functions. This enables sections of process 
screens displayed to be moved, process screens or sections of them to be zoomed using the 
mouse wheel or dragging the borders and graphic objects to be hidden and unhidden according 
to the level and object size.          ‌
The display of archive data of the WinCC option User Archives is also supported.

Using Visual Basic Scripting (VBS) it is possible to control the dynamic behavior of objects, 
for example, or establish a connection to other applications with the Web client. 
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The WinCC WebNavigator Server requires the Microsoft Internet Information Service for the 
communication to its clients. The WinCC Web Configurator is provided for setting up the 
WinCC WebNavigator Server, making configuring the Internet server simple and convenient. 
The Web Configurator is ideal for all users without Internet server knowledge: after only making 
a few entries, the Web server is properly configured.

The "Load Balancing" function enables Web Navigator Clients to be distributed automatically 
to different Web Navigator servers evenly and according to the respective server 
authorizations. 

The Web View Publisher automatically performs the necessary adaptations for the project data 
so that it can run on the WinCC Web Navigator Client. In order to achieve the best possible 
performance, the Wizard limits itself to information that is necessary for the web.

4.2 Configuring the WebNavigator Server

4.2.1 Configuring the WebNavigator Server

Introduction
The following configurations can be made on the Web Navigator server:

● The WinCC Web Configurator is used to set up and manage the Internet Information 
Service (IIS).

● The "Load Balancing" function can be used, as necessary, to set up a load distribution 
between several web servers. 

● The Web View Publisher automatically performs the necessary adaptations for the project 
data so that it can run on the WinCC Web Navigator Client via the intranet/Internet. Various 
versions of the Web View Publisher can be used and are described in Chapter "Configuring 
a Web Project". 

See also
Configuration of a Web Project (Page 110)

Load Distribution on Web Servers Using the "Load Balancing" Function (Page 95)

Wizard-Assisted Web Setup: WinCC Web Configurator (Page 82)

4.2.2 Performance of the web server and dedicated web server

Performance of your WinCC web server
The performance of WinCC projects as well as picture loading and update times on the WinCC 
Web Clients are greatly influenced by the speed and band width of the WinCC Web Navigator 
Server's Internet access. Each client requires at least approx. 10 kbps bandwidth. 
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Maximum performance can be achieved by operating the WinCC Web Navigator Server on a 
LAN. However, if the Web Navigator Server is connected to a 64K modem, a considerably 
smaller bandwidth and reduced performance are the result, which negatively affect the picture 
loading times, updating and the number of clients which can be operated simultaneously.

Performance dedicated Web Server

Tag logging
The number of trend values which the dedicated Web server can supply to the Online Trend 
Control on the Web clients, is dependent on the hardware used. 

Typical values for a system with Pentium 4, 2.4 GHz and 100 Mbit LAN:

● The dedicated Web server can supply 100 trend values per WinCC server at a cycle of 
1s.          ‌
Example: 1 WinCC server: 50 Web clients can simultaneously display 2 trends at a cycle 
of 1s, 20 trends at a cycle of 10s or 25 Web clients 4 trends at a cycle of 1s.

● The dedicated Web server can simultaneously supply 400 trend values to its Web 
clients.          ‌
Example: With 4 WinCC servers, each supplying 100 trend values, 50 Web clients can 
simultaneously display 8 trends in at a cycle of 1s, 160 trends at a cycle of 10s or 25 Web 
clients 16 trends at a cycle of 1s.          ‌
Example: With 10 WinCC servers, each supplying 40 trend values, 50 Web clients can 
simultaneously display 8 trends in at a cycle of 1s, 160 trends at a cycle of 10s or 25 Web 
clients 16 trends at a cycle of 1s.

In the case of a higher performance computer, the number of trend values which can be 
displayed simultaneously increases whereas the number of trend values per WinCC server 
remains by approx. 100 trend values at cycle time of 1s. 

Alarm Logging:
The alarm servers process the requirements of the controls sequentially. If several controls 
are reported on a server at the same time, it may take some time until the last Alarm Control 
can display its alarms. 

4.2.3 Setting up Web Folder

4.2.3.1 Wizard-Assisted Web Setup: WinCC Web Configurator

Application
The WinCC Web Configurator provides simple and uncomplicated support in administration 
and installation of Microsoft Internet Information Service (IIS). The Configurator is thus ideal 
for all users without web server knowledge. This setup and configuration is necessary to make 
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the WinCC Server accessible via the intranet/Internet. More information about the Internet 
Information Server can be obtained from Microsoft.

Standard Website Settings
Using the WinCC Web Configurator, you may also select which default website should be 
opened upon starting the web client. If "WebClient.asp" is set, the web client starts, as usual, 
with the process screens. If "MainControl.asp" is set, the web client starts with the Navigation 
interface. 

How to Start the WinCC Web Configurator
1. In the navigation window of the WinCC Explorer, select the Web Navigator and access its 

shortcut menu.

2. In the shortcut menu, select the "Web Configurator" menu command.

Note

If you have any questions or experience problems with the following settings, contact your 
intranet/Internet administrator.

Initial Configuration of the WinCC Web Navigator Server
During the initial configuration, the first dialog of the WinCC Web Configurator allows you to 
specify the creation of a new default website or a new virtual folder. For this, please observe 
the following note. The following step depends on the option selected.
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● If you only wish to operate the WinCC Web Navigator Web on your server, activate the 
option "Create a new standard website (stand-alone)".

● If the WinCC Web Navigator Web is supposed to be added as a subdirectory to your existing 
web, activate the option "Add to an existing website (virtual folder)".          ‌
This option may be necessary if the previous default website must remain active or if the 
operating system supports only the operation of one website.  

Editing the Configuration
If the IIS has already been configured, the settings of the existing web server or virtual directory 
may be changed via the WinCC Web Configurator.

The Web Configurator automatically detects an existing configuration and opens the 
corresponding dialog for making changes to the configuration.

Note

The appendix contains settings made by the WinCC Web Configurator.

If the website for the Web Navigator is accidentally deleted, restart the computer before 
creating a new website with the WinCC Web Configurator.

Please note that if manual changes were made to this website and the web communication 
fails afterwards, the Web Configurator attempts to automatically correct these settings.

If this is unsuccessful, delete the website from the IIS, restart the computer and create a new 
website with the Web Configurator.

4.2.3.2 Create New Standard Website (Standalone)

Introduction
You can create the standard website using the WinCC Web Configurator. This will also set up 
the firewall settings.
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Attitudes
You define the following settings in the "WinCC Web Configurator" dialog.

Name of the Website Specify a name for your website here, e.g. Web Navigator
Port Here you can specify the connection (port) to be used by the http protocol for accessing the 

Internet.          ‌
Only numbers ranging from 1 to 65535 may be entered.          ‌
As a rule, the port numbers up to 1024 are reserved for the system. In this field, the HTTP standard 
port 80 is set by default.         ‌
If another port number is selected, this changed number must be specified during registration of 
a web client in the address bar of the Internet Explorers after server name or URL. Possible formats 
are, for example. "http://<server_name>:<port_number>/webnavigator/maincontrol.asp" or "http://
<URL>:<port_number>/Webnavigator/maincontrol.asp". If using default port 80 and only one 
active website on the web server, this information is not needed. 

IP Address Every computer on the Internet possesses a unique address. The address consists of a group of 
four numbers that are separated by periods. The numbers can have values ranging from 0 to 255. 
The address is defined in the Windows Control Panel. You can only use addresses that are shown 
in the list-box.
Via the IP address, you can specify whether the computer is to be accessible on the intranet or 
Internet or on both networks. For example, via the IP address x.x.x.x, the computer is known to 
the intranet, via the IP address y.y.y.y to the Internet. If you want to make the computer accessible 
only on the intranet or Internet, select the corresponding address, e.g. for the intranet, this would 
be x.x.x.x.
If the computer is to be accessible via the intranet and the Internet, select "All not assigned".

Standard Website 
selection fields

Select the standard Websites here which should be displayed on the web client after selecting the 
web server. 

Reconnect interval Enter the time interval after which the web client should automatically start to establish a 
connection (Reconnect) following a connection breakdown.          ‌
If the value = 0 is set, the "Automatic connection establishment" function is disabled. 

Starting the Website 
after Configuration 

Activate this check box to automatically start the website following the configuration. 
If this check box is not activated, the website has to be manually started via the Windows console 
"Internet Information Services". 
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Procedure
1. In WinCC Explorer, select "Web Configurator" in the context menu of the "Web Navigator". 

The "WinCC Web Configurator" dialog opens.          ‌
Click "Next" to confirm.

2. Select "Create a new standard webpage (Standalone)" and confirm with "Next".
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3. Define the desired settings and confirm with "Next".
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4. The following dialog will open:

If you have not activated the firewall, the button "Windows Firewall" will not be displayed.
In this case you must close the Web Configurator by clicking "Finish".
Once you have activated the firewall, you continue with Step 5.
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5. Select the button "Windows Firewall".          ‌
The "Windows Firewall" dialog will open.
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6. Select the desired network connection in the "Advanced" tab and click "Settings...".          ‌
The "Advanced Settings" dialog will open.

7. Activate the entry "Secure web server (HTTPS)" or "web server (HTTP)". Select the button 
"Edit" to display the current service settings of the web server.

8. Exit the open Windows dialogs with "OK" and the Web Configurator by clicking "Finish".
The configuration of the server will be completed.

Results
After the configuration has finished, the newly created website (Web Navigator Web) is 
activated.

WinCC/WebNavigator Documentation
4.2 Configuring the WebNavigator Server

MDM - WinCC/WebNavigator
90 System Manual, 11/2008,  



Use of other ports besides Standard Port 80
If you do not use the Standard Port 80, then you will also need to customize the firewall settings 
accordingly.

Procedure
1. Open the "Advanced Settings" dialog via the button "Settings" in the "Windows Firewall" 

dialog.

2. Click the "Add" button.          ‌
The "Service Settings" dialog will open.

WinCC/WebNavigator Documentation
4.2 Configuring the WebNavigator Server

MDM - WinCC/WebNavigator
System Manual, 11/2008,  91



3. Define the settings for your web server:          ‌
- Name of the web server in the "Service Settings" field          ‌
- Name or IP address          ‌
- External and internal port number for this service          ‌
- Service "TCP"
Click on OK to confirm.

4. In the "Advanced Settings" dialog, select the newly created web server.

4.2.3.3 Creating a Virtual Directory

Procedure
● When selecting the radio-button "Add to an existing Website (Virtual Directory)", click the 

"Browse" button.

● In the next dialog, select the active Website to which the virtual directory is to be added.
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● After selecting the active website, click "OK" to return to the previous dialog. Click "Next".

Name of the virtual 
directory:

Here you can specify the name of your virtual directory, which is added to 
the active website.

Port and IP address The port and the IP address are predefined and cannot be edited. The 
WinCC Web Configurator reads the data of the active WinCC Web 
Navigator Server from the IIS.

Standard website 
selection fields

Select the standard websites that are to be displayed on the web client 
after selecting the web server.

Reconnect interval Enter the time interval after which the web client should automatically start 
to establish a connection (reconnect) following a connection 
breakdown.          ‌
If the value = 0 is set, the "Automatic connection establishment" function 
is disabled. 

Starting the Website after 
Configuration

Activate this check box to automatically start the website following the 
configuration. 
If this check box is not activated, the website has to be manually started 
via the Windows console "Internet Information Services". 

 

● Click "Finish" to complete the configuration.

To access the Web Navigator, the name of the virtual Web Navigator website must be added 
to the URL on the client (e.g. http://WebServer/WebNavigator).
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No Active Website
If no active Website is found, the Web Configurator terminates with a message.

Click "OK" to confirm.

Before running the Wizard again, a website must be activated. The procedure to do this is 
outlined in the chapter "Checking the activated Website".

4.2.3.4 Checking of Activated Website (Web)
● Activate the Internet Information Service.

● To do this, select "Programs" > "Management" > "Internet Information Services".

● In the navigation window, select the computer. In Windows XP, the subfolder "Websites" 
must also be selected. The data window displays the corresponding websites.

● Check the information displayed for the websites. If "Stopped" is displayed next to the 
desired website, e.g. "WebNavigator", the website needs to be started. To do this, right-
click the website and select the "Start" menu command from the shortcut menu.
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● Close the dialog.

● The website is now activated.

4.2.4 Load Distribution Using the "Load Balancing" Function

4.2.4.1 Load Distribution on Web Servers Using the "Load Balancing" Function

Overview
The "Load Balancing" function enables Web Navigator Clients to be distributed automatically 
to different Web Navigator servers evenly and according to the respective server 
authorizations. Each Web Navigator server can implement load distribution using the "Load 
Balancing" function. A web server can be configured as a distributing Load Balancing server 
or as a participating web server. A Load Balancing server is automatically a participating web 
server, too. Within a group of participating web servers, several can also be configured as 
Load Balancing servers. 

When logging on from a web client to a Load Balancing server, the web client is forwarded to 
one of the participating web servers with the least load and according to its server license. If 
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the least number of web clients are logged on to the Load Balancing server, the new web client 
remains connected to it. If a participating web server fails, the web clients registered on it are 
automatically routed to one of the other participating web servers. The address of a web server 
is independent of the activation of the "Load Balancing" function. The address of a web server 
used prior to activation continues to be valid. 

The function must be set up on each of the participating web servers and Load Balancing 
servers. In this case, all Load Balancing servers and participating web servers are recorded 
in a list. On a Load Balancing server, the query interval must also be set up and its function 
as a Load Balancing server activated or deactivated. No configuration is necessary on the web 
clients. 

Licensing
A maximum of 32 web servers connected to each other can be supported by the "Load 
Balancing" function.          ‌
A maximum of 32 web servers connected to each other can be supported by the "Load 
Balancing" function. No license is necessary on the web clients.          ‌
In the case of WinCC computers with WinCC redundancy, a Load Balancing server or 
participating web server can be operated with a "WinCC Redundancy" license and "Load 
Balancing Step-Up" license. 
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Example:

In the figure, the web servers 1 to 3 are participating in the "Load Balancing" function. A "Load 
Balancing" license is installed on these web servers. Web servers 1 and 2 are configured as 
Load Balancing servers. When web client 1 logs on to web server 1 or 2, the client is 
automatically forwarded to the web server with the lowest load. If the connected web server 
fails, web client 1 is routed to one of the other two web servers. If the web server connected 
fails, web client 1 is routed to one of the other two web servers. 

Web server 4 is not participating in the "Load Balancing" feature. If web client 2 logs on to this 
web server, the logon fails due to a high load level of the server. If web server 4 fails, the client 
is not forwarded to web servers 1 to 3 despite the fact that a network connection exists. 

 

Internet options on Load Balancing servers and participating web servers 
N: 142645 - 6.0.1 

N: 205768 - 6.1.2
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In order that the Load Balancing server can distribute the web clients to other web servers as 
they log on, the participating web servers and the Load Balancing server must be capable of 
reaching each other via the URLs mentioned in the list of participating servers.  

The use of a proxy server may cause the target address of the participating web server / Load 
Balancing servers "http://<servername>" to be replaced by "http://<servername.proxyname>" 
resulting in the web server addressed not being found.         ‌
To avoid this behavior, each of the servers participating in Load Balancing must enter the 
target address of all the other participating servers in Internet Explorer in the "Exceptions" field 
under "Tools > Internet Options > Connections > LAN Settings > Extended". 

See also
Configuring the "Load Balancing" Function (Page 98)

4.2.4.2 Configuring the "Load Balancing" Function

Introduction
The "Load Balancing" function enables Web Navigator clients to be distributed automatically 
to different Web Navigator servers evenly and according to the respective server 
authorizations.

The function must be set up on each of the participating web servers and Load Balancing 
servers. In this case, all Load Balancing servers and participating web servers are recorded 
in a list. On a Load Balancing server, the query interval must also be set up and its function 
as a Load Balancing server activated or deactivated. No configuration is necessary on the web 
clients.

Note

A web server with a "Web Navigator Diagnostics Server" license must not be included in the 
list of servers participating in load balancing. 

Requirements
● The WinCC basic system, Web Navigator server and a "Load Balancing" license have been 

installed.

● The same WinCC project must exist on each of the participating web server and load 
balancing server and the same users must have been configured.

● The standard web page for Web Navigator must have been created as stand-along page 
on the web server.
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Configuring the "Load Balancing" Function
1. Select the "WebNavigator" entry in WinCC Explorer in the navigation window. Select the 

"Load Balancing" menu item from the associated shortcut menu. The "Load Balancing 
Configuration" dialog is opened.

2. Enter the address of a web server to participate in "Load Balancing" in the top field. Click 
"Add". The address entered is transferred to the server list.
Repeat the process for each web server to participate in "Load Balancing". The name of 
the Load Balancing server must also be entered in the list.
A server name can also be deleted by selecting it in the list and clicking the "Delete" button.

Note

A web server with a "Web Navigator Diagnostics Server" license must not be included in 
the list of servers participating in load balancing.

3. Select the "Enable Load Balancing" check box to activate the local web server as the Load 
Balancing server.
The check box remains deactivated on the participating web servers.
If the check box is cleared, the list of web servers is still retained. 
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4. Use the "Polling Interval" field to select the time interval at which the other participating web 
servers should be polled.
The time is defined in seconds and is only relevant on a Load Balancing server. 

5. Click the "Save" button to store the entries.
Click "OK" to close the dialog.

6. Repeat the above procedure on all participating web servers and Load Balancing servers.

Note

The lists on the Load Balancing server and all participating web servers should be identical 
to ensure a uniform functionality should a one of the web servers fail.

The modifications take effect when WinCC Runtime is restarted.

 

4.3 Structuring with the WinCC/Web Navigator Server

4.3.1 Structuring with the WinCC/Web Navigator Server

Introduction
Before connecting your WinCC Web Server to the intranet/Internet, you must devise a concept 
taking into account your security and system conditions.

4.3.2 Island Solution
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In the above illustration, the Web Clients are not connected to the intranet, but only serve as 
HMI for the running WinCC project. You can thus set up computer stations that, for example, 
serve monitoring or maintenance functions and is cost-effective.

4.3.3 WinCC/WebNavigator Server on the WinCC Server
The WinCC Server and the server component of the WinCC Web Navigator are installed on 
one computer. The WinCC Web Navigator Client can control and monitor the running WinCC 
project via the Internet as well as the intranet. With WinCC Web Navigator Clients, a client-
server system can be expanded.

To protect against attacks from the Internet, firewalls are employed. The first firewall protects 
the WinCC Web Navigator Server from Internet attacks, the second firewall provides additional 
security for the intranet.

4.3.4 Separation of WinCC Server and WinCC/WebNavigator Server

Communication via Channel
A group of automation devices is assigned to the WinCC Server. The project includes all data 
such as programs, configuration data and miscellaneous settings. On the computer with the 
WinCC Server and the WinCC Web Navigator Server, the WinCC project is mirrored 1:1 and 
not networked with the automation devices.

The synchronization of the data takes place via the OPC channel (OPC = OLE Process 
Control). For this, the WinCC Web Navigator Server requires a license for the number of OPC 
tags.
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Two firewalls are employed here to protect the system against unauthorized access. The first 
firewall protects the WinCC Web Navigator Server from Internet attacks, the second firewall 
provides additional security for the intranet.

Communication via Process Bus
Just like in the above illustration, two firewalls are employed to protect the system against 
unauthorized access. On the computer with the WinCC Server and the WinCC Web Navigator 
Server, the WinCC project is mirrored 1:1. The synchronization of the data takes place via the 
process bus.
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4.3.5 Dedicated Web Server
For the central supply of data to the web clients, the installation of a dedicated web server is 
advantageous in larger systems. The dedicated web server processes and optimizes the 
accesses of the web clients and is available as a proxy of the WinCC servers to the clients. 
The dedicated web server can simultaneously access multiple subordinated WinCC servers. 
In this case, the user gains access to multiple WinCC projects by logging onto the dedicated 
web server (no individual project logons).

The dedicated web server supports the redundancy switch of two subordinated WinCC servers 
using WinCC Redundancy. 

The functionality of the dedicated web server is made available on a WinCC client by installing 
the Web Navigator Server. 
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4.4 Configuration of the User Administration

4.4.1 User Administration in the WinCC User Administrator

Introduction
The management of the user rights when employing the WinCC Web Navigator takes place 
in the WinCC User Administrator. Users are assigned various authorizations in it for operating 
and monitoring purposes. In addition, a start picture and the language can be configured for 
individual users in the "Web Options" area. The WinCC User Administrator thus enables the 
setup of a secure and clear user administration for WinCC and the access via the WinCC Web 
Navigator.

If a user logs onto the Web Navigator Server with the Web Navigator Client, the server will 
check whether the user is registered in the WinCC User Administrator and sends the configured 
user rights to the web client for evaluation. During login, the web server also checks whether 
the maximum number of licensed web clients has been reached. If the user is not registered, 
a log-in will not be permitted.

The tasks of the WinCC User Administrator include:
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● Creation and editing of users and user groups.

● Assignment and administration of access rights known as authorizations.

● Assignment and management of the automatic logout, start picture and the language for 
users with project access via the WinCC Web Navigator.

Support for WinCC Option "Basic Process Control" on the Web Client
The user administration of WinCC uses WinCC Web Navigator to support the following 
functions for the "Basic Process Control" option:

● Area-specific authorizations

● User-specific assignment of start picture and language

For more information on supported functionalities of the Web Navigator Client during a 
connection to a PCS7 OS, refer to the PCS7 documentation.
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Authorizations
The following authorizations can be assigned to a user:

Standard authorizations no. 1 to 999
The standard authorizations can be created, edited, deleted and assigned to users. 

The name of an authorization indicates what impact the respective authorization is to have, 
but not how it is actually used.

User hierarchies from PCS7 no. 1 to 8
These user authorizations are available after running the Wizard of the OS project editor 
(Option Basic Process Control). The predefined authorizations cannot be deleted or edited. 

System privileges no. 1000 to 1099
The system privileges are automatically generated by the system and cannot be recreated, 
edited or deleted. The system privileges can be assigned to a user just like any other 
authorization. 

System authorization No. 1002 "DataMonitor - Just monitor" has a special function when the 
WinCC Web Navigator is used. 

● If it is assigned to a user, he or she may only monitor a WinCC project ("Just monitor") and 
cannot, for example, acknowledge messages or write to tags through I/O field inputs or 
script. Client-local internal tags can continue to be written and also have to be for Basic 
Process Control.
This authorization is only relevant for the web client and does not influence other 
authorizations assigned to the user. A "DataMonitor Web Edition" license is required. If 
there is no such license, a license for a WebNavigator client is requested from the 
WebNavigator server. If a license is not available, the WebNavigator client runs in Demo 
mode after logging on.

● If it is not assigned to a user, this user may operate and monitor a WinCC project depending 
on the assigned authorizations.          ‌
A "Client" license is required.

Additional information regarding the user administration can be found in the WinCC Information 
System at "Working with WinCC" and "Configuration of the User Administration". To configure 
multilingual projects and non-Latin based fonts, information is available under "Working with 
WinCC" / "Multilingual Project Configuration".

4.4.2 Setting Web Options for Users

Introduction
For the access to a WinCC project via the WinCC/WebNavigator, certain user authorizations 
are assigned in the WinCC User Administrator to the user and are settings configured for the 
start picture and language.
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Automatic logout
The "Automatic logout" function provides the following advantages:

● The WinCC project is only accessible for a limited period from the WebNavigator client. 
This also applies in particular for unmonitored clients that still have access to the 
WebNavigator server.

● The license used by the client is released again after an automatic logout.

● The current load of the WebNavigator server is reduced after an automatic logout.

If you enter a "0" in the entry field for the period until an automatic logout, the function is 
deactivated. The user remains logged in until the Internet Explorer is closed or until the system 
is shut down.

If you use the "Absolute time" option, the configured time until the automatic logout runs from 
the moment of logging in, irrespective of the operations carried out by the user during this 
period.         ‌
If you activate the "Inactive time" option, the configured time runs from the moment of the last 
keyboard or mouse operation by the user. After this operating pause the user is logged out 
automatically.         ‌
After the monitoring time has expired, a message prompting the user to enter his password 
again is displayed. If the user enters his password during the specified time, he can access 
the WinCC project again.         ‌
If an incorrect password is entered three times or if no logon is carried out within the specified 
period, an automatic logout is effected. In the case of an automatic logout access by the client 
to the WinCC project is terminated. The license used by the client is released again.

Note

Logging on as a new user is not possible by using the dialog box that allows renewed logging 
on before the automatic logout expires. 

Configuring Web Options
1. In the WinCC Explorer, open the "User Administrator" editor.

2. In the navigation window, select the desired user or create a new user.

3. In the table window, the user authorizations existing in the WinCC project and an already 
configured assignment to this user are displayed. Check the setting of System Authorization 
No. 1002 "DataMonitor - Just monitor" and make any changes necessary.
If this system authorization is activated, the user may only observe the project (Just monitor) 
and a "DataMonitor Web Edition" license is required. If there is no such license, a license 
for a WebNavigator client is requested from the WebNavigator server. 
If this system privilege remains deactivated, the other user authorizations assigned to the 
user apply. Check the settings of the other authorizations.

4. Select the "Web Navigator" check box in the table window. The "Web Options" area is 
displayed.

5. In the "Automatic logout" field use the "Absolute time" and "Inactive time" option buttons to 
set the type of automatic logout desired. Subsequently enter the time until an automatic 
logout in the entry field.
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6. In the "Start Picture" field, use the "..." button to select the start picture for this user. As the 
start picture, only pictures that have been published with the Web View Publisher on the 
WebNavigator Server can be selected.

7. In the "Language" field, select the language for this user. Available for selection are the 
languages installed in WinCC.  

8. Close the User Administrator.

Additional information regarding the user administration can be found in the WinCC Information 
System at "Working with WinCC" and "Configuration of the User Administration". 

4.4.3 Migrating User Data from Older Projects

Introduction
Under the WinCC Web Navigator before Version 6, user rights were managed by the Web 
Administrator. From version 6 of the Web Navigator, the user administration takes place with 
the WinCC User Administrator. Old user data can be migrated with the "WebNavV6Migration" 
tool for further use in the Web Navigator V6 or higher. 

The migrated, old users are placed under the user group "WebNavigatorUserGroup" by the 
migration tool. The user authorizations of this user group are passed on to the migrated users. 
If this user group does not yet exist, it will be created by the tool and the processing stopped. 
After the desired user authorizations have been assigned to the group, the migration tool can 
be restarted. 

In addition to the password, the migration tool also transfers the user's settings pertaining to 
the start picture and the language.  

Requirements
● The WinCC Web Navigator Server has to be installed for the "Web Options" area to be 

active in the WinCC User Administrator. 

● The WinCC project into which the user data is to be migrated has to be open.

● The WinCC User Administrator for this project is a user group "WebNavigatorUserGroup". 
The group has been assigned the necessary user authorizations. 
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Migrating the User Data
1. In the Windows Explorer, select the WinCC installation folder. Access the associated 

subdirectory, "WebNavigator/Server/bin", and start the "WebNavV6Migration.exe" 
program. The user interface of the tool is only provided in English.

1. In the "Project Name" field, select the project from which the old user data is to be migrated. 

2. Confirm the selection with the "OK" button. Users of the old project are then set up in to 
open WinCC project in the "WebNabvigatorUserGroup" group and inherit the user 
authorizations assigned to the group.          ‌
If the old user database record cannot be read, an error message will be issued. In this 
case, the database driver "DAO JetEngine" from the current "Web Navigator" CD-ROM 
needs to be installed on the computer from which the user data is to be migrated into the 
WinCC project. 

3. After the successful migration, a message with the number of migrated users will be output. 
This is followed by the inquiry the old database can be deleted. Select the desired option. 
The migration tool is closed. 

4. Open the "User Administrator" editor in WinCC Explorer of the current project.          ‌
Check the settings of the migrated user and adapt them to the current project as necessary. 

5. Close the User Administrator. 

 

Additional information regarding the user administration can be found in the WinCC Information 
System at "Working with WinCC" and "Configuration of the User Administration". 
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4.5 Configuration of a Web Project

4.5.1 Configuration of a Web Project

Introduction
This chapter describes the configuration of a Web project and special features to bear in mind. 

● Publish WinCC process pictures with the Web View Publisher to compress and adapt the 
project data.           ‌
Publishing can take place in several ways, depending on the source and target folders of 
the published pictures or system structure. 

● Use the "PdlPad" tool to locate errors in the scripts used in the published WinCC process 
pictures.

● Assume and adapt existing WinCC projects to make them accessible via Intranet/Internet.

● Limitations to be taken into account.

● Differences to the WinCC the basic system 

● Using scripts           ‌
Publishing with the Web View Publisher can take place in several ways, depending on the 
source and target folders of the published pictures or the system structure. 

Multilingual projects and non-Latin fonts
The configuration of foreign language texts, user names, etc., and the use of non-Latin fonts, 
e.g. for Asian projects, is performed in the WinCC project. Certain conditions must be fulfilled 
and settings made. E.g., the desired configuration language or a special font must be installed 
in the operating system. After installing a language, it must be transferred to the Alarm Logging 
editor and Text Library so that the configuration can be made in that language or specific font. 

Additional information regarding the user administration can be found in the WinCC Information 
System at "Working with WinCC" and "Multilingual Project Configuration". To configure 
multilingual projects and non-Latin based fonts, information is available under "Working with 
WinCC" / "Language Support in WinCC". 

4.5.2 Multilingual projects and non-Latin fonts

Multilingual projects and non-Latin fonts
The configuration of foreign language texts, user names, etc., and the use of non-Latin fonts, 
e.g. for Asian projects, is performed in the WinCC project. Certain conditions must be fulfilled 
and settings made. E.g., the desired configuration language or a special font must be installed 
in the operating system. After installing a language, it must be transferred to the Alarm Logging 
editor and Text Library so that the configuration can be made in that language or specific font. 
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Additional information regarding the user administration can be found in the WinCC Information 
System at "Working with WinCC" and "Multilingual Project Configuration". To configure 
multilingual projects and non-Latin based fonts, information is available under "Working with 
WinCC" / "Language Support in WinCC". 

4.5.3 Web settings

Web settings
You define the project-specific settings in the "WinCC Web Settings" dialog box.

The dialog is opened in the WinCC Explorer in the pop-up menu of the "Web Navigator" icon 
via the "Web Settings" menu item.
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The "Compatibility" web setting 
In WinCC Web Navigator prior to version 6.2, there was a restriction for C scripts. The following 
parameters and functions did not return the complete path and the picture name but only the 
picture name on the web client. 

● Parameter "lpszPictureName"

● Function "GetParentPicture"

● Function "GetParentPictureWindow"

Starting with Web Navigator version 6.2, the user can activate the absolute addressing and 
can therefore eliminate this restriction for the web client on demand.

● Picture name:         ‌
Absolute addressing is deactivated by default. The above-mentioned functions or 
parameters only return the picture name.          ‌
The compatiblity with older web client versions and the C scripts created for them thus 
remains intact.

● Picture name and path:         ‌
If absolute addressing is deactivated, the picture name is returned with the complete 
path.          ‌
This response is in accordance with the WinCC basic system and therefore, the C scripts 
used in the WinCC basic system need not be changed to run on the web client.
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The "Runtime" Web Setting
The client-server properties are specified on the "Runtime" tab.

● Use "WinCC Classic" design: The classic design of WinCC is used instead of the enhanced 
user interface, if the WebClient is not powerful enough.

● "View only" cursor: Defines the appearance of the cursor to show that the operator cannot 
operate Runtime. The system authorization 1002 "Just monitor" was assigned to the 
operator in the user administration. Select a cursor definition file in order to change the 
appearance.

● Server load: Specify the maximum number of connections that can access the 
WebNavigator Server concurrently. The number of concurrent connections can exceed the 
number of WebNavigator server licenses if, for example, several tabs are opened in the 
Internet Explorer. A limitation to "50" is necessary, since the WebNavigator server 
guarantees a maximum of 50 connections in normal operation without additional loads. 
However, ensure that the value is not smaller than the actual number of your Web Navigator 
Server licenses.
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● Specify the maximum number of tabs that can be opened simultaneously in the Internet 
Explorer, Version 7.0 and higher. Note that generally several instances of the same Internet 
Explorer count as only one WebNavigator Server License: For example several tabs or 
new windows.

● System message: Activate the check box in order to output a corresponding system 
message when a Web client logs on or off. The check box is deactivated by default, because 
the logon and logoff system messages are not configured by default either in order to avoid 
an additional server load.

The "Gadget" Web Setting
Sidebar Gadgets are mini applications with useful information for the Windows Vista Sidebar.

A preconfigured Gadget for displaying WinCC process pictures under Windows Vista is located 
on the WebNavigator Client in the installation directory under "\WinCC\Webnavigator
\GADGET".

You combine one or more published WinCC process windows for the Gadget in the following 
dialog box on the WebNavigator Server. As soon as the Web project is in Runtime, the 
WebNavigator Server cyclically makes a jpg image, "pdlImage.jpg", consecutively of each 
process picture as a snapshot. The Gadget accesses this file cyclically in the "\WinCC
\WebNavigator\Server\Web\image\_gadget" directory again.

Note that configuring user interaction is not permitted in the displayed process pictures. This 
includes calls from login dialogs or notice dialogs via scripts for instance.

The following objects are not supported for the display in a Gadget:

● Global Script Diagnostics Window

● WinCC Media Control

● WinCC Controls from migrated projects that have been installed with versions before 
WinCC V7.0:

– WinCC Alarm Control

– WinCC Online Table Control

– WinCC User Archives Table Element

NOTICE

The project shown in the Gadget cannot be operated. A short update cycle for the 
Client Gadget places a load on the Web Server.

Example: 2 process pictures, cycle time 5 seconds

Time [s] Image

5 Process_Picture_1 -> pdlImage.jpg
10 Process_Picture_2 -> pdlImage.jpg
15 Process_Picture_1 -> pdlImage.jpg
20 Process_Picture_2 -> pdlImage.jpg
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1. Select a published process picture under "Name".

2. Specify the Runtime language for the picture.

3. Define the section of the process picture that is displayed in the Gadget. The size of the 
process picture is first determined from the project and is displayed by default at this point. 
As a rule the process picture is too large for display in the Gadget. Ensure that the clipping 
has the same width and height as the Gadget, at least the same width-to-height ratio. 
Otherwise the process picture will be displayed distorted in the Gadget or with a black frame 
around it.

4. Click "Add". The picture is added to the Gadget under "Pictures".
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5. Repeat steps 1 to 4 if necessary. The gadget then shows another picture after 17 seconds 
for example.

6. Define "Update Cycle" with the time interval in seconds to be used by the WebNavigator 
server to refresh the process pictured displayed in "pdlImage.jpg", for example, every 5 
seconds. At the beginning of the time interval, the new process picture is selected and the 
current process value is read from the PLC. At the end of the interval the snapshot is created 
and stored in "pdlImage.jpg".

CAUTION

Non-current process values displayed in Gadget

If a process value has not yet been read from the control system at the time of the 
snapshot, the start value is displayed, for example "0".

Make sure to select a sufficiently large update cycle, normally 5 seconds. Select the 
update cycle respectively larger if many process values have to be updated, e.g. for trend 
displays.

A brief update cycle on the WebNavigator Server places a load on the process 
communication.

On the WebNavigator Client:

1. Double-click the Gadget "_WebNavigator.gadget" in the installation directory under "\WinCC
\Webnavigator\GADGET". The Gadget is stored under Windows Vista in the Sidebar.

2. Define the size of the Gadget and the update cycle, in which the Gadget loads a picture 
from the WebNavigator Server, every 17 seconds for example.

3. Enter the address of the WebNavigator Server. The Gadget establishes a connection to 
the WebNavigator Server.

4. If necessary, drag-and-drop the Gadget onto the desktop.

4.5.4 Publishing WinCC Process Pictures

4.5.4.1 Publishing WinCC Process Pictures

Introduction
When configuring a Web project, the WinCC process pictures are published so that they can 
run on the WinCC Web Navigator Client via the intranet/Internet. Publishing is performed with 
the Web View Publisher which automatically makes the necessary adaptations to the project 
data. 

The following adaptations will be performed:

● Compression of the data to achieve the best possible performance on the Internet.

● Removal of project-specific data that is not required for the operation.
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● Conversion of picture windows into an ActiveX component.

● Conversion of scripts to make them operational on the WinCC Web Navigator Client.

The publishing with the Web View Publisher can take place in several ways, depending on the 
source and target folders of the published pictures or system structure. 

● Publishing on the local computer:          ‌
The source folder is the current WinCC project folder and the target folder the subfolder 
"WebNavigator/Pictures" existing in it.  

● Publishing on a dedicated web server by employing the server prefix:          ‌
The source folder is the WinCC project folder on another WinCC computer, which is 
predetermined by selecting the server prefix. The target folder is located on the WinCC 
client in the WinCC project subfolder ".../WebNavigator/Pictures".

● Remote publishing:         ‌
When publishing remote, the source and target folders can be located on one or multiple 
web servers. The publisher itself can be started on the web server with the source or target 
folder or on a third web server. 

Errors During Publishing
If warnings appear or errors occur during publishing, the process pictures affected are marked 
in the output field of the Web View Publisher. The "PdlPad" tool can be started directly in the 
publisher in order to check the scripts used in the published pictures.

A further source of errors can be due to publishing without project functions, described below. 

Publishing Without Project Functions
When publishing with the Web View Publisher, the selected project functions are always 
published. When publishing without project functions, none of the published pictures 
possesses project functions any longer. The project functions of the last publishing process 
are always available in the published pictures and, thus, on the web client.          ‌
The selection of project functions available in the Publisher is dependent on those in the 
pictures published in the same process.  If, for example, some project functions have been 
modified but not, however, their interfaces, all necessary project functions must still be 
published, not just those modified. However, not picture must be published in the same process 
if it has not been modified.

See also
Publishing WinCC Process Pictures with the Web View Publisher (Page 118)

Publishing WinCC Pictures on a Dedicated Web Server (Page 125)
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4.5.4.2 Publishing WinCC Process Pictures with the Web View Publisher

Introduction
In order to use the WinCC project in the Intranet/Internet, WinCC process pictures can be 
created or already created pictures can be used in WinCC in Graphics Designer.

Note

The names of the pictures used via the Web Navigator must not contain a double-underscore 
character, since the character string before the double-underscore is interpreted as a server 
prefix. 

If you use Basic Process Control, the name is also not to begin with a single underscore 
character. For using the Picture Tree Manager, the names of superordinate pictures are 
preceded by "@PTN_". With a leading underscore character, the picture name will then have 
a doubled underscore character.

If you are using more complex functions or scripts, please also read the corresponding chapters 
outlining the limitations, etc. If you have created your project and your pictures with the WinCC 
Graphics Designer, you will only need the Web View Publisher to make these pictures 
operational on the intranet/Internet.

The Web View Publisher automatically makes the necessary changes to the project data 
(conversion of WinCC pictures, scripts) so that they can run on the WinCC Web Navigator 
Client via the Intranet/Internet.
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How to Start the Web View Publisher:
1. In the navigation window of the WinCC Explorer, access the pop-up menu of the "Web 

Navigator" and select the "Web View Publisher".
This will start the Web Publishing Wizard. 

2. Click "Next" to go to the next dialog.
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3. In the field "Path to WinCC Project Folder", select the project directory of the WinCC project 
with the pictures to be published, e.g. "..WinCCWinCCProjects".
Use the "Publishing folder of the WinCC Web" field to select the target folder for the 
published pictures, e.g. "..\Siemens\WinCC\WinCCProjects\<project_name>
\WebNavigator".
For the untime of the Web Navigator, the folder suggested within the WinCC project folder 
must be kept as the target folder of the published pictures. The path specification should 
only be changed when pictures are to be transferred, e.g. to a different project.
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4. Click "Next" to go to the next dialog.

Select the pictures that you want to publish on the WinCC Web Navigator Server.
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5. Click "Next" to go to the next dialog.

Via ">", select the C Project Functions that are to be published. The selection of individual 
VB scripts is not possible.
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6. Click "Next" to go to the next dialog.

Select the graphics referenced in the process pictures (*.PDL) that you want to publish on 
the Web server (e.g. bitmaps). 

WinCC/WebNavigator Documentation
4.5 Configuration of a Web Project

MDM - WinCC/WebNavigator
System Manual, 11/2008,  123



7. Click "Next" to go to the next dialog.
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8. Click "Finish" to start the publishing of the pictures. You can track the progress in the 
progress display.

9. After the completion, a dialog is displayed. Confirm it by clicking "OK".
In the output field of the Publisher, the pictures in which script errors were found will be 
highlighted. By double-clicking the file name, the picture can be opened in the "PdlPad" 
and the script errors be determined and corrected.
You can exit the Wizard via the "Finish" button or change the Wizard selections with the 
"Back" button and, if necessary, publish again.

4.5.4.3 Publishing WinCC Pictures on a Dedicated Web Server

Introduction
For the central supply of data to the web clients, the installation of a dedicated web server is 
advantageous in larger systems. The dedicated web server processes and optimizes the 
accesses of the web clients and is available as a proxy of the WinCC servers to the clients. 

This results in a number of benefits:

● The load can be distributed among multiple dedicated web servers, increasing the 
performance of the total system.

● The physical separation of dedicated web server and WinCC server on different computers 
increases security.
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● The physical separation of the servers also permits a spatial separation via operational 
functions, e.g. system support and EDP department.

● The dedicated web server supports the redundancy switch of two subordinated WinCC 
servers using WinCC Redundancy.

● The dedicated web server can simultaneously access multiple subordinated WinCC 
servers. In this case, the user gains access to multiple WinCC projects by logging onto the 
dedicated web server (no individual project logons).

The functionality of the dedicated web server is made available on a WinCC Client by installing 
the Web Navigator Server. 

 

For publishing on the dedicated web servers, the WinCC Web View Publisher is used. The 
Web View Publisher automatically makes the necessary changes to the project data 
(conversion of WinCC pictures, scripts, functions) so that they can run on the WinCC Web 
Navigator Client via the Intranet/Internet. 

The published pictures are stored in the project of the WinCC client in the folder ".../
WebNavigator/Pictures". 

● Pictures of the own project under the name "<picture_name>.PD_ ".

● Pictures of different projects under the name "<server_prefix>_ _<picture_name>.PD_ ". "_ 
_.PD_ ".  

Note

The names of the pictures used via the Web Navigator must not contain a double-
underscore character, since the character string before the double-underscore is 
interpreted as a server prefix. 

If you use Basic Process Control, the name is also not to begin with a single underscore 
character. For using the Picture Tree Manager, the names of superordinate pictures are 
preceded by "@PTN_". With a leading underscore character, the picture name will then 
have a doubled underscore character.

 

When publishing pictures on the dedicated web server, the WinCC project of the WinCC 
client/dedicated web server should be open to avoid problem during the publishing of 
referenced graphics and project functions. 

The "Graphics Runtime" option must not be activated in the startup list of a WinCC project 
of a dedicated web server.

 

Customized standard functions cannot be published. If these customized standard 
functions should be available on the web client, these can be created as project functions 
and then published. 

 

Only use the WinCC Web View Publisher for projects that have been created with WinCC 
V6.2 or higher.

Another example is the "remote" publishing on a dedicated web server /WinCC client (B) from 
another computer (A). For this, the dedicated web server/WinCC client (B) must possess 

WinCC/WebNavigator Documentation
4.5 Configuration of a Web Project

MDM - WinCC/WebNavigator
126 System Manual, 11/2008,  



permissions to the project folder of its WinCC project in Windows. If the WinCC project of 
computer (B) is now opened on computer (A), the Web View Publisher can be started on 
computer (A) to publish WinCC pictures of other WinCC servers to the dedicated web server 
(B).  

Requirements
● The Web Navigator Server has to be installed on the WinCC client.

● The C and VB scripts of all WinCC servers to which the WinCC client has access must be 
present on the WinCC client.

● The packages of the WinCC servers to which the WinCC client has access must be loaded 
on the WinCC client.

● If projects should be published on other computers, this computer must be connected via 
a network before starting the Web View Publisher so that the projects can be displayed and 
selected in the publisher's selection dialog. It is not possible to enter a path directly.
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Publishing on a Dedicated Web Server
1. In the navigation window of the WinCC Explorer, access the pop-up menu of the "Web 

Navigator" and select the "Web View Publisher". This starts the Web Publishing Wizard.

2. Click "Next" to go to the next dialog.

WinCC/WebNavigator Documentation
4.5 Configuration of a Web Project

MDM - WinCC/WebNavigator
128 System Manual, 11/2008,  



3. Activate the "Server Prefix" check box. Select the prefix of a WinCC server in the "Server 
Prefix" field. The prefixes of the servers whose packages have been loaded onto the WinCC 
client are available for selection. Deleting a prefix from the selection automatically changes 
the displayed paths in the fields below.
In the field "Path to WinCC Project Folder", select the project directory "\\<server_name>
\<server_prefix>_ _<project_name>" of the WinCC project with pictures to be published. 
Check the target folder of the published pictures in the "Publishing folder of the WinCC 
Web" field. Change the set path, if necessary. 
For the runtime of the Web Navigator, the folder suggested within the WinCC project folder 
must be kept as the target folder of the published pictures. The path specification should 
only be changed when pictures are to be transferred, e.g. to a different project. In this case, 
the prefix selection list will be expanded accordingly.  
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4. Click "Next" to go to the next dialog.

Select the pictures that you want to publish on the WinCC Web Navigator Server.
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5. Click "Next" to go to the next dialog.

Via ">", select the C Project Functions that are to be published. The functions present in 
the project of the WinCC client are available for selection in the "Files" field. The selection 
of individual VB scripts is not possible.
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6. Click "Next" to go to the next dialog.

Select the graphics referenced in the process pictures that you want to publish (e.g. 
bitmaps).
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7. Click "Next" to go to the next dialog.
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8. Click "Finish" to start the publishing of the pictures. You can track the progress in the 
progress display.

9. After the completion, a dialog is displayed. Confirm it by clicking "OK".
In the output field of the Publisher, the pictures in which script errors were found will be 
highlighted. By double-clicking the file name, the picture can be opened in the "PdlPad" 
and the script errors be determined and corrected.
You can exit the Wizard via the "Finish" button or change the Wizard selections with the 
"Back" button and, if necessary, publish again.

4.5.4.4 Remote Publication of WinCC Process Pictures with the Web View Publisher

Introduction
In order for the WinCC project data (pictures, scripts) to be operational on the WinCC Web 
Navigator Client via the Intranet/Internet, it is published with the help of the Web View Publisher.

When publishing remote, the source and target folders can be located on one or multiple web 
servers. The publisher itself can be started on the web server with the source or target folder 
or on a third web server. 
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Requirements
● Remote Publishing can only be used on the Web Navigator Server or if the Web Navigator 

Remote Publisher has been installed but not, however, with the dedicated web server.

● The Web View Publisher must receive Windows permissions to the source and target 
projects. By default, these permissions are created by WinCC. Check, however, whether 
these permissions are not limited, for example, to certain users.

● If projects should be published on other computers, this computer must be connected via 
a network before starting the Web View Publisher so that the projects can be displayed and 
selected in the publisher's selection dialog. It is not possible to enter a path directly.

● For remote publication of the WinCC project on a dedicated web server, the project must 
have been opened remotely on the publishing computer.          ‌
For remote publication of the WinCC project on a dedicated web server, the project must 
have been opened remotely on the publishing computer, of WinCC Explorer must be closed.

 

Note

The names of the pictures used via the Web Navigator must not contain a double-underscore 
character, since the character string before the double-underscore is interpreted as a server 
prefix. 

If you use Basic Process Control, the name is also not to begin with a single underscore 
character. For using the Picture Tree Manager, the names of superordinate pictures are 
preceded by "@PTN_". With a leading underscore character, the picture name will then have 
a doubled underscore character.

Customized standard functions cannot be published. If these customized standard functions 
should be available on the web client, these can be created as project functions and then 
published. 

Only use the WinCC Web View Publisher for projects that have been created with WinCC 
V6.2 or higher.
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Remote Publishing with the Web View Publisher
1. In the navigation window of the WinCC Explorer, access the pop-up menu of the "Web 

Navigator" and select the "Web View Publisher".
This starts the Web Publishing Wizard. 

2. Click "Next" to go to the next dialog.
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3. In the field "Path to WinCC Project Folder", select the source project where the WinCC 
pictures are located. The source project will be shown using the permission name on the 
other WinCC servers. The selection made appears in the field in the format"\
\<computer_name>\<enable_name>.
In the "Publishing Folder of the WinCC Web" field, check the target project information in 
which the converted pictures are to be stored. The path is adjusted during the selection of 
the source project. Should the target project be located on another WinCC server, select 
the corresponding project. 

4. Click "Next" to go to the next dialog.

Select the pictures that you want to publish on the WinCC Web Navigator Server.
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5. Click "Next" to go to the next dialog.

6. Via ">", select the C Project Functions that are to be published. The selection of individual 
VB scripts is not possible.
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7. Click "Next" to go to the next dialog.

Select the graphics referenced in the process pictures that you want to publish on the Web 
server (e.g. bitmaps). 
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8. Click "Next" to go to the next dialog.
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9. Click "Finish" to start the publishing of the pictures. You can track the progress in the 
progress display.

10.After the completion, a dialog is displayed. Confirm it by clicking "OK".
In the output field of the Publisher, the pictures in which script errors were found will be 
highlighted. By double-clicking the file name, the picture can be opened in the "PdlPad" 
and the script errors be determined and corrected.
You can exit the Wizard via the "Finish" button or change the Wizard selections with the 
"Back" button and, if necessary, publish again.

4.5.5 Transfer and Adaptation of Existing Projects

Introduction
Projects already created with WinCC can be used to make them available via Internet and 
intranet.

Essentially, this requires the publishing of the already created WinCC pictures with the WinCC 
Web View Publisher in the WinCC Web folder and the setup of the web users with the WinCC 
User Administrator. 
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Note

Only use the WinCC Web View Publisher for projects that have been created with WinCC 
V6.2 or higher.

For projects that have been converted from WinCC V6 to WinCC V7, the instructions on 
migration into the WinCC Basic documentation must be observed. 

The current version of the WinCC Web Navigator has many limitations in its functionality and 
does not support all functions that a standard WinCC Basic system offers as a "Thin Client". 

Check your existing WinCC configuration with regard to these limitations and adapt it if 
necessary.

NOTICE

In the WinCC Web Navigator, only a certain number (approximately 600) of functions and 
standard functions are available, which you can use on the WinCC Web Navigator Client. A 
list of functions with are supported or not supported by the WinCC Web Navigator Client is 
provided in the Appendix.

4.5.6 Limitations
When transferring the extensive WinCC Runtime functionality to the minimal Runtime 
environment of the WinCC Web Navigator Client, limitations are unavoidable. 

The following WinCC options and functionalities are not available, amongst others, via the 
Intranet/Internet on the Web Navigator Client: 

When using non-supported functions, the user will be informed of this in Runtime with plain 
text messages.

● The WinCC Web Navigator Client only offers the view of a running WinCC project. A 
configuration of the WinCC Server projects via the web client is not possible.

● Only those WinCC option packages/add-ons can run on the WinCC Web Navigator, whose 
documentation expressly states that.

● Not all ODK functions are supported on the WinCC Web Navigator Client. A list of the 
functions supported is provided in the Appendix.

● Web Navigator Client does not support all functions of WinCC basic system with Basic 
Process Control. A description of supported and non-supported functions may be found in 
WinCC Information System under "Options > Options for Process Control > System 
Overview Controlling Options > Configuration in PCS7 Environment > Web Client" as well 
as under "Release Notes > Controlling Options".

● The Report Designer is an integrated reporting system of WinCC for the time- or event-
triggered documentation of alarm messages, operations and archive contents. This 
reporting system is not supported via the Intranet/Internet. Thus, the output of reports is, 
for example, only possible on the Web Navigator Server and WinCC client.
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● No separate archive system is running on the WinCC Web Navigator Client. The message 
archive and message system can only be operated and monitored.

● Computer-local tags in conjunction with user archives are not supported on the web client. 
For additional information, go to "Differences with basic system > Computer-local tags".

● The redundancy switch is only supported on the dedicated web server.

● - In ActiveX Control "WinCC Alarm Control", the property "triggers an action" is not 
supported. In Alarm Control, selection according to alarm class is only possible on a Web 
client executed locally on the Web server.
To ensure correct display on the Web client, the checkboxes in the "Apply Project Settings" 
area must not be activated in the WinCC project in the configuration of the "WinCC Alarm 
Control" on the Message Blocks tab control. 

● Operation using the hotkeys configured in WinCC is not supported by the Web Navigator 
client because Internet Explorer does not distinguish between operating objects from 
WinCC and its own.          ‌
On the other, operations using the tab key are supported.

● Certain objects of the Global Library of WinCC are not supported by Web Navigator 
Client.          ‌
In Web Navigator, these are the objects "1_Slider", "2_Slider" and "4_Slider" from the 
directory "Global Library / Operation / Operating Panels".

● National special characters in names of process pictures or references graphs are not 
supported by the web client during Internet connections.

4.5.7 Using Scripts

VB Scripts
When using Visual Basic Scripts, there are only small limitations due to unsupported functions. 
The appendix contains an overview of these functions.

Global Script
The WinCC Web Navigator Client only offers a view of the project. The configuration of scripts 
takes place in the server project of the WinCC server. 

Global Scripts cannot run on the web client. Global Scripts on the server are supported.

Unlike in WinCC, all scripts on the WinCC Web Navigator client are integrated in the same 
name space. This makes possible function calls between scripts that are implemented in 
different objects. Global tags are known to all scripts. For this reason, "defines" - such as 
"#define Motor 1 100" - that are stored in scripts of this file may only occur once across all 
scripts.

If multiple occurrences are required due to configuration reasons, "define" needs to be 
deactivated first by a "#undef".

Example:
#undef Motor1
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#define Motor1 200
 

Special features
Project functions which should run on the Web Navigator Client must not use include-files. The 
PdlPad tool provides support in examining problems in the pictures used and displaying 
problem points.

Scripts created with the Dynamic Wizard are, in part, not capable of running on the Web 
Navigator Client because functions which are not supported may be used in the scripts. If these 
scripts should be capable of running on the web client, they must be tested by the user and 
corrected, e.g. by inserting the condition "#ifdef RUN_ON_WEBNAVIGATOR". 

Actions
Actions are scripts that respond to operations and events. The appendix of the Online Help 
contains the functions that are supported.

Scripts with Tag Triggers
Tags are polled in the Web Navigator in a cycle of one second and not in the configured cycle 
time. This can lead to an increased load for the communication connection between the AS 
and WinCC server and must be taken into close consideration when the communication 
between AS and WinCC server is operated at utilization load limits. 

If other tags are requested in tag triggered scripts whose names, e.g. are created with a string 
function, these tags can only be read synchronously (in as far as they are not known). This 
can lead to unusually long execution times. To prevent this happening, enter the tags names 
used in the trigger list.

Diagnostics for VBS and Global Script
The WinCC Web Navigator supports the diagnostics for VBS and Global Script through the 
application window. 

When placing the application window in the process picture for the VBS and Global Script 
diagnostics, select the window content "Global Script" and the template "GSC Diagnostics". 

4.5.8 The "PdlPad" Tool

Introduction
Installing the WinCC Web Navigator Server will also install the "PdlPad" tool, with which the 
scripts of the published pictures can be checked. 

In order to check the scripts, open the published picture in PdlPad and click the "Check Scripts" 
icon. Corrections to the scripts can be entered in PdlPad and saved. These correction, 
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however, are only saved in the published pictures, not in the process picture of the WinCC 
project. 

Starting PdlPad: 

● Double-click "PdlPad.exe" in the installation directory "\Webnavigator\Server\bin" 

Starting from the Web View Publisher
The Web View Publisher automatically makes the necessary adaptations to your WinCC 
process pictures so that they can run on the WinCC Web Navigator Client via the Intranet/
Internet. These published pictures are in the WinCC project folder under " ..\ WebNavigator \ 
Pictures".  

If the "Check Scripts" check box is activated when running the Web View Publisher, the 
published pictures in which script errors were found will be highlighted in the output field of the 
Publisher. By double-clicking the file name, the picture can be opened in the PdlPad and the 
errors be determined and corrected. 

Additional information about publishing can be found at the topic "Publishing WinCC Process 
Pictures".

Starting from the Windows Start Menu 
To check the scripts of a published picture, open this picture in the PdlPad from the WinCC 
project folder under " ..\ WebNavigator \ Pictures". 
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4.5.9 Differences to the WinCC Basic System

4.5.9.1 Picture Selection
In Web Navigator, a WinCC picture is downloaded asynchronously over the Internet. 
Therefore, in contrast to the Basic System, the picture change asynchronous rather than 
synchronous. This fact must be taken into consideration for scripts which trigger a picture 
change.

The following applies:

If, within a script, a picture window triggers the selection of a picture, objects of the new picture 
are subsequently not accessible within the same script since the picture has not been loaded 
at that particular time. Any delay (such as Sleep(2000)) is of no help here as the script and 
Internet Explorer wait along with the delay.

A better solution is to execute the subsequent script parts during an OpenPicture Event which 
will be triggered once the picture has loaded.
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4.5.9.2 Scripting

Screen deselection
You can use the ANSI C function, SetPictureName, in a C script, for example, to deselect a 
screen.

If you call other functions in the script, they will not be executed or they will be executed with 
error. The context of the screen is lost when the screen is deselected.

Preprocessor definition
Especially for Web Navigator, there is a preprocessor definition in scripting:

RUN_ON_WEBNAVIGATOR

Code subject to this preprocessor definition will be executed in Web Navigator only. Thus it is 
possible to write scripts which perform differently under Web Navigator than in the Basic 
System.

Example:
 
void OnOpenPicture (char* lpszPictureName, char* lpszObjectName, 
char* lpszPropertyName)
{
#ifdef RUN_ON_WEBNAVIGATOR
// enter here code to be executed only in the Navigator
#else
// enter here code that is executed only in the basic system
#endif
}

4.5.9.3 Script Execution
In contrast to the WinCC Basic System, the event-triggered scripts (OnClick etc.) are executed 
inn the same process space as the picture display, namely within the context of Internet 
Explorer.

This must be noted when working with delays in scripts (for example, Sleep(3000)). In this 
case, the displayed picture is not accessible for exactly that time span.

4.5.9.4 Synchronous Script Functions
Synchronous script functions present a high load on the system. The "SetTagxxx" function in 
particular should not be used in cyclic scripts. If several clients (>10) call the SetTagxxx 
functions in a fast cycle (1s or less), the server is overloaded.
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For synchronous script functions, such as "xxxWait", which perform a synchronous tag write 
and subsequent wait on the result, as well as CApi calls, it should be noted that these calls go 
synchronously to the server. Therefore, a frequent call to these script functions may seriously 
and adversely affect the performance of the web client. Using an Internet connection, such 
call may even take up to the order of seconds.

Script functions which manipulate the objects within the displayed picture are of no concern 
as the roundtrip to the server does not materialize.

4.5.9.5 Addressing of Objects in Pictures

Note

From version 6.1 SP1, Web Navigator supports the absolute addressing of objects in pictures. 
Therefore, there is no longer any difference to the WinCC basic system. 

In Web Navigator versions prior to V6.1 SP1, only relative addressing was possible which 
Web Navigator continues to support. However, a description no longer exists. 

 

4.5.9.6 Defining a Picture-Local Script Tag
In order to keep picture-specific data in scripts, one should avoid using WinCC tags in Web 
Navigator. These tags, if read or written in scripts, always involve a round trip to the server, 
thus placing a load on the communication.

There are several options to maintain picture-specific data:

Configuration of "invisible" graphic objects
By creating invisible graphic objects, one has the option to use the properties of these invisible 
objects as a picture-specific tag.

In addition, it has the advantage of executing certain actions upon changes of these saved 
values.

Example: Creating an invisible text field.
Here you may save any arbitrary texts in TextProperty which then can be read or written by 
any script handler.

In the color properties of the text field, for example, you may save colors which are read and 
written using scripts and may affect the picture status without requiring a roundtrip to the server. 
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4.5.9.7 Computer-local Tags

Overview
The WinCC/WebNavigator client supports computer-local tags.

Take the following features into account:

● With the dedicated Web Server

● With text tags

● With User Archives

Computer-local tags with the dedicated Web Server
When using a dedicated web server, only the computer-local tags of the dedicated web server 
are available on the web client. Therefore, these tags cannot assume their own values on the 
web client. 

Computer-local tags of subordinate WinCC servers
The computer-local tags of the subordinate WinCC server cannot have separate values on the 
Web Client.

Special characters in computer-local text tags
The start value of computer-local tags may only contain characters that are allowed in the tag 
names. For example, a colon in the start value leads to the tag not being recognized on the 
Web Client.

More information on special characters can be found in the WinCC Information System under 
the topic "Working with WinCC" > Working with projects > Appendix > Impermissible 
characters".

Computer-local tags and user archives
Computer-local tags in conjunction with user archives are not supported on the web client. 

4.6 Using the WinCC/Web Navigator Client

4.6.1 Using the WinCC/Web Navigator Client

Introduction
The WinCC Web Navigator Client allows viewing, operating and monitoring a running WinCC 
project of the WinCC server. Because of this, no configuration of the server project is possible.
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The functions and properties of the Web Navigator Client are described in the following chapter. 

4.6.2 Functions and General Properties of the Web Client

Establishing of a Connection (Reconnect) by the Web Clients Automatically Connection Error
If the communication between the web client and web server is defect, the user receives a 
message on the web client. The message appears, for example, on terminating WinCC 
Runtime on the WinCC server within 10s, following a power failure on the web server within 
60s.          ‌
The web client then automatically tries to establishing a connection in order to restore the 
connection. Following reconnection, the Start page of the WinCC project is selected.          ‌
 A condition for this is that a connection was established successfully between the web client 
and web server beforehand. 

The delay between attempts to establish a connection can be configured on the web server 
in the Web Configurator. If the value "0" is set, the web client does not attempt to reconnect 
automatically. 

Connecting the Web Client to a different version of web servers 
If a Web Navigator Client is to be connected to a Web Navigator Server of a different version, 
such as V1.2, please read "Mixing and Compatibility of Versions" in the Chapter 
"Requirements". 

Monitor Keyboard
A virtual keyboard on the picture is unhidden on the Web Navigator client, as with WinCC, with 
which to enter numeric and alphanumeric input. The keyboard can be displayed on the web 
client regardless of the configuration in the WinCC project.

The application must be selected and installed in the client installation.

The settings for the monitor keyboard are defined in the Web Navigation user interface in the 
"Settings" menu. If the Web Navigation user interface define the settings directly in the 
"ClientConfig.asp" file. The file can be opened in the Internet Explorer using the address "http://
<server_name>/ClientConfig.asp". 

Further information on the screen keyboard is provided in the corresponding chapters in the 
WinCC Information System. 

Installing Downloads or Plug-Ins on the Web Client
If a download or plug-in should be installed on a web client from the web server just connected, 
no other web client may be stared on this client computer or an attempt to establish a 
connection to the same server from another open Internet Explorer window. This also applies 
when the web clients on a client computer are connected to different web servers. It is generally 
recommended to close al the other unnecessary applications on the client computer during 
the installation of the Web Navigator software. 
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If ActiveX controls are also installed along with a plug-in, the Internet Explorer must be closed 
and reopened.  

Communication
The communication between the WinCC Web Navigator Server and Client is possible via HTTP 
and HTTPS. To protect the system against unauthorized access, HTTPS should be used.

Multiple instancing by a new window in Internet Explorer
Multiple instancing through several separate windows is not supported on the Web Client. 

The multiple instancing will be created if the function "New Window" in the menu "File > New 
> Window" is used in the Internet Explorer.

 [block-title]⊳Multiple instancing using tabs in the Internet Explorer
As of Version 7.0 the  Internet Explorer supports several tabs and tab groups with Web pages 
in a single Internet Explorer window (tabbed browsing). This allows you to set up several views 
of the project in the Web Client. Example: Tab 1 shows "Screen 1", Tab 2 shows "Screen 2".

Overlapping Lock
An overlapping lock in process pictures is not supported on the web client.  

Persistency in Runtime
The files concerning persistency on the web client are in the folder "Documents and Settings / 
User / Application Data / WebNavigator". The Control Settings in which Runtime Persistence 
was activated, may only be reset by resetting the individual settings in Control or by deleting 
the file.

- Persistence in RT on a standard server

The persistency data is stored on the web client specifically for pictures and objects. If work 
is carried out with several projects on the server and these projects contain pictures or objects 
of the same name, observe the following. If a Persistence in RT is created for a project, the 
persistency is transferred for the picture of the same name to the other projects.

- Persistence in RT with dedicated web server

If two WinCC clients are connected to the same WinCC server in a system, it is irrelevant, from 
the aspect of the persistence in RT, via which WinCC client the web client is connected to the 
WinCC server. Once the persistency settings have been defined for a server picture, these 
settings are available on the respective web client. It is irrelevant with which WinCC client the 
web client is connected.

Project Change
After changing the WinCC project on the web server, the Web Configurator must be executed 
again so that the web clients can connect to the web server again. 
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Language Change
A language switch can be implemented on the WinCC Web Navigator Client.

If a text from the Text Library is changed on the WinCC server in Runtime, this may not be 
automatically recognized by the WinCC Web Navigator Client. The Internet Explorer saves 
the pictures in the cache. The cache is a special memory in which the content of frequently 
used objects, e.g. Internet pages, are stored. In order to refresh the displayed pictures, the 
picture has to be reloaded via the "Refresh" icon or the "F5" key.

Language-Dependent Text When Using Text References
Language-dependent text output through text references is displayed on the web client in the 
language currently set on the respective WinCC server.

The same applies to multi-user systems where a WinCC client with its own project has, for 
example, text references of a second WinCC server loaded via packages. If a web client or a 
WinCC client are registered on this WinCC client with their own project, the text references of 
the second WinCC server appear in this client in its current language.  

Customized ActiveX Controls
Customized ActiveX Controls (Industrial X), inserted in WinCC, also work on the web client 
when they are installed on the client computer. The Controls can be compressed so that they 
can be downloaded. To do this, the WinCC Plug-In Builder can be used, for example. Further 
information is available under "WinCC Plug-In Builder" or the IndustrialX hotline.

WinCC Slider Control
In the case of WinCC Slider Control, the "ContinousChange" attribute should be set to "No" 
during configuration in WinCC. If the attribute is set to "Yes", an event trigger is started following 
a minimal position change which can results in a heavy load for the communication of the web 
client.

Zoom Function in Runtime
The extended Zoom functions in Runtime cannot be deactivated on the web client. If the zoom 
functions are not required for use, do not use a wheel mouse with the Auto Scroll setting on 
the web client.

Access to Process Tags
Process tags can be read and written just like at the WinCC client. The process image is 
supplied with tag values by the WinCC Explorer. Depending on the authorizations issued in 
the WinCC User Administrator, the web client user can either only monitor ("System privilege 
No. 1002") or operate and monitor.

When using the DataMonitor, the Web Navigator is used for the transfer of information and for 
the user administration. While the Web Navigator Client represents a complete HMI system, 
the DataMonitor client is a pure display and evaluation system for process values from WinCC 
or data from the WinCC long-term archive server. 
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Mouse Cursor and Operable Objects with Lacking Authorization
In WinCC Basis System process pictures, the mouse cursor is displayed over operable objects 
without the green dynamization arrow if the registered user does not have sufficient 
authorization. Equally, operable objects are displayed as deactivated if sufficient authorization 
is lacking. 

In the Web Navigator Client these objects with insufficient authorization appear as if operable 
due to system constraints. These objects are not deactivated due to system constraints, and 
the mouse cursor is displayed with the dynamization arrow over the objects. Only upon 
attempted operation or value input, a message appears that the user does not have sufficient 
authorization. 

4.6.3 Web Client Properties Concerning Pictures

Update Cycle for the Tag Connection with Direct Connection
In the case of tag connection with direct connection, a tag value with configured "Upon Change" 
update cycle is updated on the web client in cycles of "1 second". This must be taken into 
account, for example, when displaying tag values.  

Display of messages
The existing WinCC message archive or WinCC servers alarm logging system can be operated 
and monitored on the WinCC Web Navigator Client via the WinCC Alarm Control. The 
execution of the function "Loop in Alarm" is not possible.

Display of Process Values in Trends and Tables
On the WinCC Web Navigator Client, the display of the process values in trend or table form 
can be implemented via the WinCC Online Trend Control and the WinCC Online Table Control. 
Changes with regard to the trend and table windows are possible. The Web Navigator Client, 
however, cannot have its own archive, the data of the process values comes exclusively from 
the archive system of the WinCC server. Several properties of the controls cannot be changed 
on the Web client, such as the archive and tag selection and the persistence settings.  

Display of Archive Values in Trends and Tables with Open Picture
When displaying archive values with the Online Trend Control and Online Table Control, the 
"Open Picture" setting in the configuration of these controls must be taken into account. In the 
Control properties, the option "Load Archive Data" in the "Open Picture" area of the General 
tab control should be selected. This option is not active in the Control properties on the web 
client, and this is why the current setting is not displayed and cannot be changed.          ‌
If the option is not set, no data are displayed for the open picture on the web client.  Only after 
clicking the "STOP" and "GO" buttons in the toolbar of the Controls, values are displayed.  
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Display value of a user archive using User Archives Table Control
Changes in a user archive trigger an update of the User Archive Table Controls which display 
exactly the contents of this user archive. The following factors affect the performance of 
process pictures with User Archive Table Control on the web client and should be noted. 

● The number of User Archive Table Controls accessing the user archive at the same time 
should be kept as low as possible.

● Cyclic changes to the user archive should be utilized as little as possible.

● The communication load of the connection to the web server also has an effect.

Picture in Picture Technology and Cyclic Scripts
If several windows (>10) are configured in a picture window and cyclical scripts with 
synchronous calls are used in these windows (e.g. SetTagxxx), the numerous synchronous 
calls can lead to performance problems and, under certain circumstances, some scripts may 
not be executed due to timeouts. At present, only 16 windows with cyclic scripts are supported 
in one window. If no cyclic scripts are used, 31 windows can be enabled in one window.

The "Sizeable" property cannot be implemented in picture screens in web clients. The user 
cannot change the screen size at runtime.

Picture Change
In the event of a picture change on the web client, global C-tags are reinitialized.

When triggered, the OpenPicture() function opens the parent picture of the executing object 
in the dedicated web server.          ‌
For more information on addressing, refer to "Differences to the WinCC Basic System" / 
"Addressing Objects in Pictures".

Picture Change on Dedicated Web Server
If a picture with a server prefix was loaded on the dedicated Web server / WinCC client, no 
picture from the local WinCC project can subsequently be displayed without the server prefix. 
To display a picture from the local WinCC client project, the "@local" server prefix must be 
used during the addressing, e.g. "@local::picture123.pdl" for addressing the picture 
"picture123". 

Displaying a Modified Process Picture on the Web Client
If a process picture is modified in WinCC Graphics Designer on a computer with web server 
and WinCC in Runtime, whereby the picture is displayed on a web client, the modified process 
picture must be published again. This is the only way that the modifications can be displayed 
on the web client. The display may have to be updated manually depending on the settings in 
the web client's Internet Explorer under "Internet Options > Temporary Internet Files > 
Settings". 

This process also applies for modifications of control properties, such as persistency settings 
of the Tag Logging Controls. 
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To assume the modifications made on a web client on a dedicated web server, the relevant 
WinCC project is opened remotely on the dedicated web server. The modified picture is then 
opened and stored in Graphics Designer and then published by Web Publisher to the dedicated 
web server. If several pictures or one large picture are modified, the process can be simplified 
by the "Convert pictures" in the pop-up menu of Graphics Designer. The modified picture or 
pictures must also be published subsequently. 

Possible Causes of Error Messages on the Web Client
On publishing with checking of the scripts, pictures are signaled by the fact that warnings and 
errors occur. These pictures are still published and can be selected by clients. However, 
Runtime errors can occur which are signaled by the client.

Project Functions in Pictures
When a project is selected for the first time the project functions are loaded after the startup 
picture has been loaded. Therefore, a delay can occur between the first display of the startup 
picture and execution of operations; i.e. the picture is displayed but can only be operated after 
approx. 1 second.  

If a project function called from a picture is no longer available in the project, no project 
functions run in this picture. Further information is available in the Chapter "Configuring a Web 
Project" / "Publishing Without Project Functions". 

4.6.4 "Hardcopy" Function on the Web Client

Introduction
The current view of the web client can be output on a standard printer. The hardcopy can be 
triggered by a configurable key combination or a script. The definition of the key combination 
or the screen area to be printed out can be set at the start of the hardcopy application. The 
function can be used by all web clients.

Starting the Hardcopy Application
To use the Hardcopy function, the "PrtScr.exe" application is implemented which can be 
downloaded as a Plug-In from the web server. The application is started on the web client, 
e.g. via the command line, by entries in the AutoRun Group or via a script. Hardcopy is then 
triggered according to the parameters defined.  

Parameters Function

Without 
parameters 

Not permissible on the web client!          ‌
"infinit" can be used as a substitute. 

-end Terminates a running instance of PrtScr.exe 
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Parameters Function

-hardcopy Starts PrtScr.exe, directly triggers a hardcopy and then waits for the key 
combination.          ‌
Only use on the web client in combination with the "infinit" and "hotkey" 
parameters!  

-nomcp Starts PrtScr.exe, directly triggers a hardcopy and then ends PrtScr.exe 
/C= 
left;top;right;bottom 

Starts PrtScr.exe, directly triggers a hardcopy of the indicated screen area and 
then ends PrtScr.exe (please note the space following "/C=") )          ‌
Example: prtscr.exe /C= 50;50;100;100 

-l Prints in landscape format         ‌
 This parameter can be added to any parameter combination.

-infinit Indicates that there is no connection to the WinCC project and that no key 
combination has been defined, for example, on the web client. The parameter 
must be used in combination with "hotkey". 
If the parameter is used in connection with the parameters "hotkey" and "/C= 
left;top;right;bottom", PrtScr is started and then waits for the key combination. If 
the key combination is pressed, the hardcopy of the screen area 
"left;top;right;bottom" is output. 

-hotkey=„x„ Designation of the key combination. The following key combinations are 
permitted:          ‌
{ <ALT>, <SHIFT>,<CTRL>} +  {0-9, A-Z, 0xXX}
The parameters must be written using capital characters. The keys <ALT>, 
<SHIFT> and <CTRL> can be combined with each other, but this is not a 
requirement.          ‌
By means of the hexadecimal value 0xXX, all virtual key codes can be expressed 
for XX. The "Virtual Key Codes" can be taken from the Online Help of the 
DeveloperStudio. 
Example:          ‌
hotkey=„<CTRL>+P„      key combination „CTRL„ und P         ‌
hotkey=„0x2C„               PRT SCR key ( „Print-Screen„)         ‌
hotkey=„<ALT>+0x2C„    key combination „ALT„ and "PRT SCR„ 

The parameters must be separated by a space. In addition, the parameters are case-sensitive!

Examples of Parameter Combinations for the Web Client

Hardcopy upon Key Combination  

PrtScr.exe –infinit –hotkey=„<ALT>+p„ Starts PrtScr and waits for the key combination 
<ALT>+p. If the key combination is pressed, the 
entire screen is printed.

PrtScr.exe –infinit –hotkey=„<ALT>+p„ –C= 
10;10;100;100

Starts PrtScr and waits for the key combination 
<ALT>+p. If the key combination is pressed, the 
selected section is printed.

Starting in a Script  
PrtScr.exe –nomcp Starts PrtScr, directly triggers a hardcopy and then 

ends PrtScr.
PrtScr.exe –C= 10;10;100;100 Starts PrtScr, directly triggers a hardcopy of the 

selected section and then ends PrtScr.
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4.7 WinCC/Web Navigation Interface

4.7.1 WinCC Web Navigation Interface

Introduction
The WinCC Web navigation interface combines various Web functions and makes them 
available to the user in a clear format.          ‌
The contents of the navigation interface can be expanded by the user.          ‌
Language switching is supported.

In the basic version of the interface, the following functions are integrated. 

● "Change server" menu:

– In the upper field you enter a new address of a Web Server directly.⊳[br/]⊲ The address 
is stored.

– In the lower field you enter a short name for the Web server. This is shown in the 
navigation column under "Used servers" instead of the address.

● "Used servers" menu:          ‌
Navigation to the Web servers previously used.⊲[/p]

● Menu of the current server:

– "Process pictures": Display or navigation to the process pictures of the current web 
server.

– Report tools: Installed tools such as "DataWorkbook" for the display and analysis of 
current process values and historic data.

– Analysis tools: Installed tools such as "DataView" for the display of archive data from 
the WinCC Central Archive Server (WinCC CAS) in tables and trends.

– "Diagnostics": WinCC Scope and Status.html for diagnosing the WinCC project and the 
connection to the web server.

– Additional tools": This menu can be expanded by the user.

– "Download area":  This is used to download documents and other files from the Web 
Server which have been made available there by or for the user, e.g. to download add-
ins for the Web Navigator and system or to integrate additional, application-specific web 
components created as plug-ins with the Web Navigator Plug-In Builder.

● "Settings" menu:          ‌
Settings for the web client, such as size adaptation of process pictures, activation of the 
monitor keyboard, locking key combinations.  
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● "Current" menu:          ‌
Links to Web pages, such as "SIMATIC HMI", "WinCC" or "WinCC flexible".

● "Language" menu:          ‌
Changing the language of the navigation user interface. The standard version of the 
program includes five languages.  
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User Logon
When logging onto the web server, the user can determine - through the address entered in 
the Internet Explorer - whether he or she logs on via the Web navigation interface or the start 
page configured in the WinCC project. 

● The address "http://<server_name>/webnavigator" opens the start page configured in the 
User Administrator following the logon.

● The address "http://<server_name>/webnavigator/maincontrol.asp" starts the Web 
navigation interface.

Change of the Server
Via the menu entry "Change Server", a different server can be selected. In the upper input 
field, the URL of the new server is entered. Examples of possible input formats are described 
under "User Logon".          ‌
In the lower field, a symbolic name can be entered, which is shown in the menu as the current 
server. If no entry is made, the URL of the server is shown.  

Expansion Options

Menu
The menu of the navigation interface can be expanded by additional menu entries and 
functions, for example, depending on the operational area. To do so, these expansions are 
configured in an XML file, which is then stored on the web server in the subfolder 
"_custom_data". Further information is available in the topic "Extending the Web Navigation 
User Interface".  

Tools
The menu entry "Additional tools" can be expanded by the user to provide additional tools on 
the web client.

Plug-Ins
The "Download Plug-Ins" menu option provides plug-ins that have been stored on the web 
server in the folder "Install/Custom". In order to display the version name of a plug-in, it must 
have been assigned the format "Vxx.xx.xx.xx" or "xx.xx.xx.xx". 

Languages
Adjustment of language options may be facilitated by adjusting the "Menu.xml" file. The 
languages are stored as CSV files on the web server in folder "_languages / 
<language_identifier>. When adding, these language files have to be referenced in the file 
"maincontrol.asp". 
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4.7.2 Expanding the WinCC Web Navigation Interface

Introduction
The menu of the Web Navigation interface may be expanded by additional menu items and 
functions. An expansion is configured in an XML file. 

The XML file is saved on the web server in subdirectory "_custom_data". The file name may 
be chosen arbitrarily since all files with the extension "XML" in this directory are processed. 

Example:
This example adds to menu "Server" a submenu "My Private Menu" with three additional 
subitems "My Link","Relative Link" and "Run Script". 

Code Description

<?xml version="1.0"?> Version information
<menu hook-on="server"> In command "menu hook-on", the key name 

"server" is referenced which defines the menu 
"Current Server" on the Web Navigation interface. 

<caption><lng>My Private Menu</lng></caption> Line 3 defines an empty menu item.
<command>         ‌
<caption>My Link</caption>         ‌
<open-url target="right">http://www.msdn.com</
open-url>         ‌
</command>

Lines 4-7 define the menu item "My Link" with a 
direct link. 

<command>         ‌
<caption>Relative Link</caption>         ‌
<open-url target="right">project.asp</open-
url>         ‌
</command>

Lines 8-11 define the menu item "Relative Link" 
with a relative link.

<command>         ‌
<caption>Run Script</caption>         ‌
<run-script>alert("Hallo !")</run-script>         ‌
</command>

Lines 12-15 define the menu item "Run Script" 
which starts a script.

</menu> Conclusion of menu.

4.8 Installation of the WinCC Plug-In Builder

4.8.1 Installation of the WinCC Plug-In Builder

Introduction
With the WinCC Plug-In Builder, a setup program can be created for the download of additional 
Web components by the web clients. These plug-ins can be downloaded by the user, e.g. via 

WinCC/WebNavigator Documentation
4.8 Installation of the WinCC Plug-In Builder

MDM - WinCC/WebNavigator
160 System Manual, 11/2008,  



the Web Navigation user interface, installed and extend the functional scope of its web clients 
as individually.          ‌
The individual downloading and installing mean that the resources of the web clients are not 
unnecessarily exposed to excessive loads. This means, for example, that a plug-in can be 
created for an individual or system-specific group of WinCC ActiveX Controls and then installed 
on certain web clients. 

Using the Plug-In Builder does not require knowledge of setup technology or other 
development programs.

The created plug-in setup takes the form of a self-extracting EXE file, which can be made 
available for download to the web clients from a folder on the web server. 

A Web Navigator plug-in integrates into an already installed Web Navigator Client and is also 
deinstalled with it.

The setup programs created with the Plug-In Builder can only be used in the Web Navigator 
environment.
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4.8.2 Installation of the Plug-In Builder

Introduction
The software for the WinCC/WebNavigator Plug-In Builder is installed on the computer from 
the WinCC DVD.

Procedure
1. Insert the WinCC DVD into the DVD drive. The setup program will start automatically after 

a few seconds, provided that the autorun functionality is not disabled.
If you are installing from a network drive or the autorun function is deactivated, start the 
setup manually. This requires that you go to the Windows start menu and select "Settings 
> Control Panel > Software" and then click on the "Add new programs" icon. Then select 
the required installation medium.

2. Choose "User" for the "Installation type".

3. Select the installation of WinCC/WebNavigator-Plug-In Builder.
The respective setup program is started.

4. Click "Next" and follow the instructions on the screen.
The WinCC/WebNavigator Plug-In Builder is installed.

4.8.3 Plug-In: Creating, Testing and Making available for Download

Introduction
The Plug-In Builder gives you an overview of the existing plug-in projects and their status.

Buttons provide the functions for creating and testing of a plug-in. The arrangement of the 
buttons from left to right corresponds to the steps of creating a new plug-in.

In the field "Installed Web Navigator Software“, you can see the Web Navigator components 
installed on the computer. Various functions of the Plug-In Builder are only available if certain 
Web Navigator components are present.  

After the start, the Plug-In Builder checks the build versions of the already created plug-ins 
located on the computer. If a later version of the Plug-In Builder is installed, earlier plug-ins 
may loose their validity and have to be regenerated.

All plug-ins that are no longer valid or have not yet been generated is displayed in a list.

The Plug-In Builder contains a template for the version information, from which the version 
information for all other plug-ins can be derived from. This template cannot be changed.
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Note

The version information of a plug-in should not contain any umlauts. 

 

For the file selection, the window "Common Files registered" can only accept self-registering 
files (*.EXE, *.OCX, *.DLL.). Other files are rejected by the Plug-In Builder. However, the 
system does not check whether the stored files are self-registering.         ‌
Also note that the files introduced may cause registration problems during the plug-in 
installation, since the registration function is carried out independently by the file. The user 
is responsible for the specific registration. The user is responsible for the specific registration.

 

Requirements
● The function "Test Plug-In" requires the installation of the Web Navigator Client. 

● The function "Export Plug-In" requires the installation of the Web Navigator Server. 
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Creating a Plug-In
1. Start the Plug-In Builder in the Windows Start menu by selecting "SIMATIC" > "WinCC" > 

"Web Navigator" > "Web Navigator Plug-In Builder". Proceed by clicking the "Next" button. 
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1. Click the "New Plug-In" button. The "New Plug-In" dialog opens to enter various plug-in 
version information. Enter the data and complete the input by clicking "OK". Confirm the 
following prompts to apply the new plug-in or modifications.          ‌
If you require a template for the version information, select the "Template" project in the 
"Plug-In Projects" window and then click the "Modify Plug-In" button. The template is 
displayed but cannot be edited.          ‌
Following the creation, this project is shown in the field "Plug-In Projects".

2. Click the "Files" button. The "Files" dialog opens in which to select the files integrated in 
the plug-in. In the area "Source Path", select the drive and the path in which the desired 
files are located.          ‌
The files can be copied with drag&drop in the "Common Files" or "Common Files registered" 
window. The "Common Files" window is used for any file, the window "Common Files 
registered" for self-registering files (*.EXE, *.OCX, *.DLL).          ‌
To delete a file from one of the two windows, drag it to the recycle bin at the bottom of the 
dialog.           ‌
Click the "OK" button to conclude the file selection.  

3. Select the newly created plug-in project from the project list and click the "Build Plug-In" 
button. The "Build Plug-In" dialog opens. The project title and the path for the generated 
plug-in are displayed.          ‌
Clicking "OK" closes the dialog without performing the generation.         ‌
Start generating the plug-in by clicking the "Start" button. The progress of the building 
process is displayed. Following the conclusion of the generation, clicking "Logfile" displays 
the corresponding log file.          ‌
Click "OK" to close the dialog. The completed generation is indicated in the field "Build 
Status" with "Build done".  

4. To test the plug-in, click the "Test Plug-In" button. This function can only be called when 
the Web Navigator Client is installed. The "Test Plug-In" dialog is opened. The project title, 
the path and the status of the plug-in are displayed.          ‌
Start the installation by clicking the "Install" button. Completion of the test is indicated in 
the "Status" field by the "Setup completed" message.          ‌
Click "OK" to close the dialog.  

5. To export the plug-in to the web server, click the "Export Plug-In" button. This function can 
only be called when the Web Navigator Server is installed. The "Export Plug-In" dialog is 
opened. The project title, the path and the status of the plug-in are displayed. Start the 
export process by clicking the "Export" button. Completion of the test is indicated in the 
"Status" field displaying the path specification of the exported plug-ins.           ‌
Click "OK" to close the dialog.   

6. Close the Plug-In Builder by clicking "Exit". 

4.8.4 Installation and Deinstallation of a Plug-In on a Web Client

Installation of a Plug-In
A plug-in is an expansion of the web client and is usually offered and installed via the Internet. 

In the Web navigation interface, the available plug-ins can be selected and installed via the 
menu entry "Download Plug-Ins". 
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For testing purposes, a plug-in can also be installed with the "Test Plug-In" function of the Plug-
In Builder. For this, the Web Navigator Client has to be installed on the computer. The plug-in 
setup is then run completely autonomously.

In order to install a plug-in, at least main user rights are required. 

Providing a Plug-In for Download
At the WinCC Web Navigator Server, plug-ins are stored in the subfolder "Web/Install/Custom" 
of the installation folder. If a web server is installed on the same computer as the Plug-In 
Builder, the finished plug-in can be exported directly to the Web Navigator Server. 

If the Plug-In Builder and the web server are not installed on the same computer, the plug-in 
has to be transferred manually. 

Deinstallation of a Plug-In
A plug-in is an expansion of the web client and as such does not possess its own deinstallation 
program.

A plug-in is not listed as an installed software by the Windows Control Panel, but instead is 
automatically deinstalled with the Web Navigator Client.

4.9 Diagnosis of the Connections with "Status.html"
The "Status.html" page is used for diagnosing the WinCC Web Navigator Server and its 
connected, active clients.

The status information is shown in blocks:

● one information block pertaining to the server

● one information block each pertaining to each connected client or Diagnose Client

The call to the site is made in Internet Explorer by using the address "http:///status.html" if Web 
Navigator exists as a stand-alone website. If Web Navigator was created as a virtual website, 
the address is "http://<server_name>/webnavigator/status.html". 

The display appears in English only.

Access to this page is password-protected (users and passwords set up in the User 
Administrator).

Note

The displayed status information can be saved. To do this, use the "Save As" menu option 
in Internet Explorer and select "(*.txt)" as the file type.  If "(*.htm, *.html)" are selected, the 
contents displayed are not saved. 
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Structure of the Information Block of the Web Navigator Server

Field Description

Server Version Displays the Web Navigator Server version (build no.)
Server File Date reserved
Last Update Date and time of the display's last update 
Connected Clients  Number of connected clients 
Connected Diagnose Clients  Number of connected Diagnose Clients
Connected View Only Clients  Number of connected View Only Clients
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Structure of the Information Blocks of the Web Navigator Clients
Below the caption "Logged on Users:" the information blocks of the connected clients are listed. 
Each block has the name of the client as a header.

Field Description

Login Login name of the current user
Time Login time of the current user or also time of the most recent automatic 

reconnect. 
Type Type of web client, such as Default, Demo, View Only 
PID   Process ID of entity of WebNavigatorRT.exe on web server 

communicating with this web client. 

 

4.10 Use of Terminal Services for WinCC/WebNavigator

4.10.1 Use of Terminal Services for WinCC/WebNavigator

Introduction
Terminal services of Windows Servers offer several Terminal Services clients the option of 
accessing the Desktop of such a Terminal Services Server. Various applications, such as MS 
Word, are carried out on Windows Servers. However, the Terminal Services only transfer the 
user interface of the applications to the clients. Each client's keyboard inputs and mouse 
operations are returned back to the server.

The WinCC WebNavigator Client has already been created in "THIN" architecture: It is 
executed multiple times on the Terminal Server and places low requirements on the hardware.
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Terminal Servers have the following advantages:

● Robust hardware with low memory requirements, for example without fans and hard disk 
in a dusty environment, can be used as Thin Clients.

● Mobile clients with limited power consumption (such as handheld devices, palmtops) can 
be used as Thin Clients.

● All applications are located on the server in a secure environment.

● Easier, central administration and system maintenance.

● Various operating systems are supported: Windows CE, Windows Mobile, Windows XP, 
Vista, etc.

For redundant system configurations with terminal services, please consult the corresponding 
Microsoft documentation.

Note

The terminal services client supports only 256 colors.

Bitmaps whose size can change, "Live video", greatly strain the terminal service and should 
be avoided.

4.10.2 Communication Using Terminal Services

Communication Using Terminal Services
When using the web client as the terminal services client, there must not be any proxy server 
used between terminal services server and Web Navigator Server.

If the servers for Terminal Services and Web Navigator, to be accessed by web clients using 
Terminal Services, are not installed on the same computer, the web clients will not be able to 
access the web server via the terminal services. This problem can be solved in various ways: 

● A minimal installation of the WinCC basic system without licenses is installed on the terminal 
services servers.

● After installing the web client, the file "CCEClient_service.vbs" is executed once on the 
terminal services server. The file is available in the "Updates\WebNavigator" folder of the 
WinCC DVD. The Windows user right "Administrators" is required to execute the VBS file.

Access of Web Client and WinCC clients to the web server
If a Web client should access the Web server using Terminal Services, the Web client (Terminal 
Services Client) no Windows desktops may be opened during its session if WinCC clients 
should also have access to this Web server. 

To ensure the Windows desktop is not opened on the Web client when beginning a session, 
enter Internet Explorer as the start program either direct in the Terminal Services configuration 
(for all users) or in the computer management (for individual users).
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4.10.3 WinCCViewerRT

Introduction
The Web Viewer is solely a display program for Web projects that is installed with the 
WebNavigator Client. The particularly thin "THIN" Terminal Service application 
"WinCCViewerRT.exe" is carried out on the WebNavigator client instead of the Internet 
Explorer. In the Web Viewer you specify the Web Server address and the settings for the 
Graphics Runtime.

The settings are stored by default in the configuration file "WinCCViewerRT.xml". You can 
modify the name, for example "Operator1.xml". Alternatively you can start the Web Viewer by 
using the command line and specifying a user-specific configuration file: "WinCCViewerRT.exe 
Bediener1.xml". This allows different configurations to be used, depending in the logged-on 
user. The interface language of the Web View is taken from WinCC.

Load distribution with load balancing is not supported
The "load balancing" function is not supported by the "WinCCViewerRT.exe" application.

The load distribution using Load Balancing is controlled through a Web page. Since clients do 
not select Web pages via WinCCViewerRT, participating in Load Balancing is not possible.

NOTICE

If you disable a shortcut or hide the "Close" button, it is no longer possible to close Web 
Viewer. The project shown in the Web Viewer cannot be operated.
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Setup

1. Double-click "WinCCViewerRT.exe" in the installation directory "Siemens\WinCC
\Webnavigator\Client\bin".

2. Enter the data for logging on at the Web Server in the "General" tab: Server address, user 
name and password. The "Version" field is optionally used to connect to a WebNavigator 
Server running a previous version for example "V 6.1".

3. In the "Parameters" tab specify the Runtime language and whether shortcuts which the 
user uses to change to other programs are to be disabled.

4. Define the WinCC Runtime properties in the "Graphics Runtime" tab:
- Start Picture
- Configuration file for picture navigation
- Window Attributes
- Impermissible user actions

5. Define additional user actions in the "Runtime" tab.
- Automatic logout
- Enable monitor keyboard.
- Use <Ctrl+Alt+Del> to switch to the Task-Manager and the operating system.
- Call the Web-Viewer with key combination. You can change the default key combination 
of <Ctrl+Alt+P>.

6. Close the dialog with the "OK" button. The connection to the Web Server is established.
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4.10.4 Terminal Services Setup

Introduction
The following chapters explain how to set up the terminal services for a simple example in 
connection with the WinCC Web Navigator Client.

Requirements
WinCC Basis and WinCC Web Navigator Server must not run under the terminal services and, 
as a result, must be installed on the server before activating the terminal services with the 
following configuration steps.  

Configuration steps
1. Activation of the terminal services (terminal services server).

2. Installation of the application, e.g. WinCC Web Navigator Client (terminal services server). 
This issue is not described here. Information pertaining to the installation can be found in 
the corresponding documentation and the Online Help. 

3. Setting up of client data carrier (terminal services server).

4. User setup for the access via the terminal services (terminal services server).

5. Installation of a client (client computer).

6. Configuration of the terminal services connections (client computer).

7. Start of the application on the client.

Additional information may be found under the topic "Terminal Services" in online help of 
Windows 2000 Server and Windows Server 2003, respectively.

4.10.5 Activation of Terminal Services on Windows Server
The terminal services can be activated in two different modes. 

1. Remote Administration Mode: In this mode, the terminal services allow a remote access to 
a server from any location on the network. In this mode, the programs to be used can be 
installed before or after activating the terminal services. The terminal services licensing 
needs not to be activated.

2. Application Server Mode: In this mode, Windows programs may be distributed safely and 
effectively using a network server. The programs to be used with the terminal services 
should be installed after activating the terminal services, since the terminal services register 
these programs for multi-user access and provide improved management.

For this example, the application server mode is required, which is activated as follows:

● Insert the CD-ROM labeled "Windows 2000 Server" or "Windows Server 2003"          ‌
into the CD-ROM drive of the server.

● From the start menu of Windows, select menu item "Settings" > "Control Panel" and click 
the "Add or remove programs" icon.
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● Open the "Add or Remove Programs" dialog and click "Add or Remove Windows 
Components". The "Windows Components Wizard" dialog opens.

● In the components selection window, activate the check-boxes of the "Terminal Services" 
and "Terminal Services Licensing" options and then click "Next".

● Select the "Application Server Mode" option.

● Click "Next".

● In the "Setup of the Terminal Services" dialog, activate the "With Windows 2000 users 
compatible rights" check-box and then click "Next".

● In the dialog showing the applications, click "Next".

Note

This dialog may show applications that cannot be executed properly upon the activation of 
the terminal services. These applications have to be reinstalled via the Control Panel's "Add 
or Remove Programs" dialog after activating the terminal services.

● In the "Terminal Services Licensing - Setup" dialog, select the "Your domain or workgroup" 
option and specify the folder for the licensing database of the server.

● Click Next" and then on "Finish".

This starts the file copying process. After a restart of the computer, the copied server software 
becomes available.

 

Note

The terminal services have to be installed on the server before the installation of the actual 
applications. The installation of the applications on the server has to be performed via the 
"Add or Remove Programs" dialog of the Control Panel. Since this dialog uses the server 
installation mode, the configuration of the applications is later possible for all users and not 
just for the user, who installed the application.

  

4.10.6 Setting Up a User with Access Rights to the Terminal Services Server
For the access to the terminal services server, a user has to be set up on the server. The user 
administration and the settings of Windows also apply to the terminal services.

● From the start menu of Windows, select the "Settings" > "Control Panel" entries and then 
click the "Administrative Tools" icon.  Click the "Computer Management" icon.

● In the "Computer Management" dialog, click the "System Tools" > "Local Users and Groups" 
folders.

● Right-click the "Users" folder and select the "New User" menu command from the displayed 
pop-up menu.
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● In the "New User" dialog, enter a user name and a password.

● Activate the "Password never expires" check box.

● Click "Create".

● Close the dialog.

Note

The user created here on the terminal services server is also needed for the configuration of 
the connection on the terminal services client. For more information, refer to "Configuration 
of the Connection".

4.10.7 Starting the Terminal Serves Server Applications on the Client Computer
After installing the terminal services client on the client computer and creating a connection 
file, an application of the terminal services server can be started on the terminal services client.

● From the start menu of Windows, select the "Settings" > "Control Panel" entries and then 
click "Terminal Services Client" > "Client Connection Manager" icon.

● click the connection that has been assigned to the terminal services server.

● In the "Log On" dialog, enter the password and confirm it by clicking "OK".

● The connection is established. Once the terminal services server's desktop is displayed, 
its applications can be started, e.g. the Web Navigator Client via the Internet Explorer.

4.11 Appendix

4.11.1 Troubleshooting

No Communication Between WinCC Web Navigator Server and Client 
If a provider (participating proxy, firewall) has activated Content Filtering for an Internet 
connection, Web Navigator communication is no longer possible. With content filtering, only 
certain contents of HTML pages are permitted. In this case communication is is effected via a 
defined port to an IP address.

● Deactivate smart filtering at the WinCC Web Navigator Server for its IP address.

Connection Abort
In an Internet environment, aborted connections, delays and communication fluctuations may 
occur.         ‌
If the communication between the web client and web server is defect, the user receives a 
message on the web client.          ‌
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The web client then automatically tries to establishing a connection in order to restore the 
connection. 

The delay between attempts to establish a connection can be configured on the web server 
in the Web Configurator. If the value "0" is set, the web client does not attempt to reconnect 
automatically. In this case a message appears on the web client asking you whether the 
connection is to be reestablished. 

Confirm this query to reestablish the connection.

For further information see the topic "Using the WinCC Web Navigator Client > Functions and 
General Properties of the Web Client > Automatic Connection Establishment (Reconnect) of 
the Web Client in Case of Connection Faults". 

No Pictures are Displayed
Make sure the correct web site is activated on the computer running the WinCC Web Navigator 
Server. For more information see the chapter "Checking the Activated Website".

Wrong Startup Picture
You have edited a new picture in the Graphics Designer.

● Start Web View Publisher to publish the new picture thus making it available to the Internet.

● Delete the temporary Internet files in the Internet Explorer via "Tools" > "Internet Options".

● Delete the Firewall cache.

● You can assign an individual startup picture to each operator in the user administration.
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4.11.2 Abbreviations

Overview

Abbreviation Description

DNS
HTTP
HTTPS
IE
IIS
IP
ISP
IT
LAN
OPC
PIN
PWS
SP
SSL
TCP
TCP/IP
UNC name:
VPN
WWW:

Domain Name System
Hyper Text Transfer Protocol
HTTPS is an expansion of the HTTP protocol
Internet Explorer
Internet Information Service
Internet protocol
Internet Service Provider
Information Technology
Local Area Network
OLE Process Control
Personal Identification Number
Personal Web Server
Service Pack
Secure Socket Layer
Transmission Control Protocol
Transmisson Control Protocol/Internet Protocol
Name corresponding to the Universal Naming Convention
Virtual Private Network
World Wide Web

4.11.3 System messages
System Message No. 1012400 is output when a Web Client is logged on at the WebNavigator 
Server.

System Message No. 1012401 is output when a Web Client is logged off at the WebNavigator 
Server.

4.11.4 Functions

4.11.4.1 Supported functions

Functions
WaitForDocumentReady

Get_Focus
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GetTagCharWait

GetTagChar

GetTagCharStateWait

GetTagCharState

GetPropChar

GetText

GetFontName

GetAssignments

GetInputValueChar

GetOutputFormat

GetOutputValueChar

GetLastChange

GetPictureName

GetServerName

GetBasePicture

GetFlashPicture

SetTagMultiWait

SetTagMultiStateWait

SetTagRaw

SetTagRawState

SetTagRawStateWait

GetTagMultiStateWait 

GetTagMultiWait

AXC_OnBtnArcLong

AXC_OnBtnArcShort

AXC_OnBtnLoop

AXC_OnBtnMsgFirst

AXC_OnBtnMsgLast

AXC_OnBtnMsgNext

AXC_OnBtnMsgPrev

AXC_OnBtnMsgWin

AXC_OnBtnScroll

AXC_OnBtnSinglAckn

AXC_OnBtnVisibleAckn

AXC_SetFilter
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AXC_OnBtnComment

AXC_OnBtnEmergAckn

AXC_OnBtnInfo

AXC_OnBtnLock

AXC_OnBtnSelect

OnBtnArcLong

OnBtnArcShort

OnBtnComment

OnBtnEmergAckn

OnBtnHornAckn

OnBtnInfo

OnBtnLanguage

OnBtnLock

OnBtnLoop

OnBtnMsgFirst

OnBtnMsgLast

OnBtnMsgNext

OnBtnMsgPrev

OnBtnMsgWin

OnBtnPrint

OnBtnScroll

OnBtnSelect

OnBtnSinglAckn

OnBtnVisibleAckn

TLGGetTemplateParameter  

TLGPressToolbarButton

TlgGetColumnPosition

TlgGetNumberOfColumns

TlgGetNumberOfRows

TlgGetNumberOfTrends

TlgGetRowPosition

TlgGetRulerArchivNameTrend

TlgGetRulerTimeTrend

TlgGetRulerValueTrend

TlgGetRulerVariableNameTrend
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TlgGetTextAtPos

TlgTableWindowPressFirstButton

TlgTableWindowPressLastButton

TlgTableWindowPressNextButton

TlgTableWindowPressNextItemButton

TlgTableWindowPressOpenArchiveVariableSelectionDlgButton

TlgTableWindowPressOpenItemSelectDlgButton

TlgTableWindowPressOpenTimeSelectDlgButton

TlgTableWindowPressPrevButton

TlgTableWindowPressPrevItemButton

TlgTableWindowPressStartStopButton

TlgTrendWindowPressFirstButton

TlgTrendWindowPressLastButton

TlgTrendWindowPressLinealButton

TlgTrendWindowPressNextButton

TlgTrendWindowPressNextItemButton

TlgTrendWindowPressOneToOneButton

TlgTrendWindowPressOpenArchiveVariableSelectionDlgButton

TlgTrendWindowPressOpenDlgButton

TlgTrendWindowPressOpenItemSelectDlgButton

TlgTrendWindowPressOpenTimeSelectDlgButton

TlgTrendWindowPressPrevButton

TlgTrendWindowPressPrevItemButton

TlgTrendWindowPressStartStopButton

TlgTrendWindowPressZoomInButton

TlgTrendWindowPressZoomOutButton

SetLink

GetLink 

SetLanguage 

GetLanguage

GetServerTagPrefix 

OpenPicture 

GetLinkedVariable 

GetLocalPicture

GetParentPicture
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GetParentPictureWindow

SetPictureDeactivated

SetPictureDown

SetPictureUp

fopen 

freopen 

fflush 

fclose 

remove 

rename 

setvbuf 

setbuf 

fprintf  

printf  

sprintf  

vprintf  

vfprintf 

vsprintf 

fscanf  

scanf  

sscanf  

fgetc 

fgets 

fputc 

fputs 

getc 

getchar  

gets  

putc 

putchar  

puts  

ungetc 

 fread 

fwrite 

fseek 
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ftell 

rewind 

fgetpos 

fsetpos 

clearerr

feof 

ferror 

perror  

atof 

atoi 

atol 

strtod 

strtol 

strtoul 

rand 

srand 

calloc 

malloc 

SysMalloc

realloc 

free 

abort 

exit 

atexit  

system 

getenv 

bsearch 

qsort 

abs 

labs 

div 

ldiv 

_splitpath

_makepath  

strcpy 
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strncpy 

strcat 

strncat 

strcmp 

strncmp 

strchr 

strrchr 

strspn 

strcspn 

strpbrk 

strstr 

strlen 

strerror 

strtok 

memcpy 

memmove 

memcmp 

memchr 

memset 

clock 

time 

difftime 

mktime 

asctime

ctime 

gmtime 

localtime 

strftime

Check

ProgramExecute 

GetPropBOOL

GetPropDouble

GetPropLong

GetPropWord

GetMax
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GetMin

GetAlignment

GetAxisSection

GetExponent

GetLeftComma

GetLongStrokesBold

GetLongStrokesOnly

GetLongStrokesSize

GetLongStrokesTextEach

GetRightComma

GetScaling

GetScalingType

GetScaleTicks

GetBackColor

GetBackColor2

GetBackColor3

GetBackColorBottom

GetBackColorTop

GetBorderBackColor

GetBorderColor

GetBorderColorBottom

GetBorderColorTop

GetButtonColor

GetColorBottom

GetColorTop

GetFillColor

GetForeColor

GetGridColor

GetItemBorderBackColor

GetItemBorderColor

GetScaleColor

GetSelBGColor

GetSelTextColor

GetTrendColor

GetUnselBGColor
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GetUnselTextColor

GetFilling

GetFillingIndex

GetBorderFlashColorOff

GetBorderFlashColorOn

GetBackFlashColorOff

GetBackFlashColorOn

GetForeFlashColorOff

GetForeFlashColorOn

GetFlashBackColor

GetFlashBorderColor

GetFlashForeColor

GetFlashRateBackColor

GetFlashRateBorderColor

GetFlashRateForeColor

GetAlignmentLeft

GetAlignmentTop

GetFontBold

GetFontItalic

GetFontSize

GetFontUnderline

GetOrientation

GetLayer

GetActualPointLeft

GetActualPointTop

GetBoxCount

GetDirection

GetEndAngle

GetGrid

GetGridHeight

GetGridWidth

GetHeight

GetLeft

GetPointCount

GetRadiusHeight
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GetRadius

GetRadiusWidth

GetRotationAngle

GetRoundCornerHeight

GetRoundCornerWidth

GetReferenceRotationLeft

GetReferenceRotationTop

GetStartAngle

GetTop

GetWidth

GetZeroPoint

GetAssumeOnExit

GetAssumeOnFull

GetBitNumber

GetClearOnError

GetClearOnNew

GetDataFormat

GetHiddenInput

GetListType

GetNumberLines

GetAlarmHigh

GetAlarmLow

GetColorAlarmHigh

GetColorAlarmLow

GetCheckAlarmHigh

GetCheckAlarmLow

GetCheckLimitHigh4

GetCheckLimitHigh5

GetCheckLimitLow4

GetCheckLimitLow5

GetCheckToleranceHigh

GetCheckToleranceLow

GetCheckWarningHigh

GetCheckWarningLow

GetColorLimitHigh4
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GetColorLimitHigh5

GetColorLimitLow4

GetColorLimitLow5

GetColorToleranceHigh

GetColorToleranceLow

GetColorWarningHigh

GetColorWarningLow

GetLimitHigh4

GetLimitHigh5

GetLimitLow4

GetLimitLow5

GetLimitMax

GetLimitMin

GetMarker

GetTypeAlarmHigh

GetTypeAlarmLow

GetToleranceHigh

GetToleranceLow

GetTypeLimitHigh4

GetTypeLimitHigh5

GetTypeLimitLow4

GetTypeLimitLow5

GetTypeToleranceHigh

GetTypeToleranceLow

GetTypeWarningHigh

GetTypeWarningLow

GetWarningHigh

GetWarningLow

GetAdaptBorder

GetAdaptPicture

GetAdaptSize

GetAverage

GetBoxType

GetCaption

GetColorChangeType
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GetCloseButton

GetCursorControl

GetEditAtOnce

GetExtendedOperation

GetHotkey

GetHysteresis

GetHysteresisRange

GetLanguageSwitch

GetMaximizeButton

GetMoveable

GetOffsetLeft

GetOffsetTop

GetOnTop

GetOperation

GetOperationMessage

GetOperationReport

GetPasswordLevel

GetProcess

GetSmallChange

GetScrollBars

GetSizeable

GetTrend

GetUpdateCycle

GetVisible

GetWindowBorder

GetZeroPointValue

GetZoom

GetPosition

GetRangeMax

GetRangeMin

GetPicDeactReferenced

GetPicDeactTransparent

GetPicDeactUseTransColor

GetPicDownReferenced

GetPicDownTransparent
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GetPicDownUseTransColor

GetPicReferenced

GetPicTransColor

GetPicUpReferenced

GetPicUpTransparent

GetPicUpUseTransColor

GetPicUseTransColor

GetBasePicTransColor

GetBasePicUseTransColor

GetBasePicReferenced

GetFlashFlashPicture

GetFlashPicTransColor

GetFlashPicUseTransColor

GetFlashPicReferenced

GetFlashRateFlashPic

GetIndex

GetBackBorderWidth

GetBorderEndStyle

GetBoxAlignment

GetBorderStyle

GetBorderWidth

GetFillStyle

GetFillStyle2

GetItemBorderStyle

GetItemBorderWidth

GetPressed

GetToggle

GetWindowsStyle

GetInputValueDouble

GetOutputValueDouble

GetPictureDeactivated

GetPictureUp

GetPictureDown

// ------------------------------------------------------------------------------------------------

// --- internal Functions (SET)  ---
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// ------------------------------------------------------------------------------------------------

SetPropBOOL

SetPropChar

SetPropDouble

SetPropWord

SetPropLong

SetAxisSection

SetLeftComma

SetLongStrokesBold

SetLongStrokesOnly

SetLongStrokesSize

SetRightComma

SetScaling

SetScalingType

SetScaleTicks

SetBackColor

SetBackColor2

SetBackColor3

SetBackColorBottom

SetBackColorTop

SetBorderBackColor

SetBorderColor

SetBorderColorBottom

SetBorderColorTop

SetButtonColor

SetColorBottom

SetColorTop

SetFillColor

SetForeColor

SetItemBorderBackColor

SetItemBorderColor

SetScaleColor

SetSelBGColor

SetSelTextColor

SetTrendColor
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SetUnselBGColor

SetUnselTextColor

SetFilling

SetFillingIndex

SetBorderFlashColorOff

SetBorderFlashColorOn

SetBackFlashColorOff

SetBackFlashColorOn

SetForeFlashColorOff

SetForeFlashColorOn

SetFlashBackColor

SetFlashBorderColor

SetFlashForeColor

SetFlashRateBackColor

SetFlashRateBorderColor

SetFlashRateForeColor

Set_Focus

SetAlignmentLeft

SetAlignmentTop

SetAlignment

SetFontBold

SetFontItalic

SetFontName

SetFontSize

SetFontUnderline

SetOrientation

SetText

SetActualPointLeft

SetActualPointTop

SetBoxCount

SetDirection

SetEndAngle

SetHeight

SetLeft

SetPointCount

WinCC/WebNavigator Documentation
4.11 Appendix

MDM - WinCC/WebNavigator
190 System Manual, 11/2008,  



SetRadiusHeight

SetRadius

SetRadiusWidth

SetRotationAngle

SetRoundCornerHeight

SetRoundCornerWidth

SetReferenceRotationLeft

SetReferenceRotationTop

SetStartAngle

SetTop

SetWidth

SetZeroPoint

SetAssumeOnExit

SetAssumeOnFull

SetBitNumber

SetClearOnError

SetClearOnNew

SetHiddenInput

SetNumberLines

SetOutputValueChar

SetOutputValueDouble

SetAlarmHigh

SetAlarmLow

SetColorAlarmHigh

SetColorAlarmLow

SetCheckAlarmHigh

SetCheckAlarmLow

SetCheckLimitHigh4

SetCheckLimitHigh5

SetCheckLimitLow4

SetCheckLimitLow5

SetCheckToleranceHigh

SetCheckToleranceLow

SetCheckWarningHigh

SetCheckWarningLow
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SetColorLimitHigh4

SetColorLimitHigh5

SetColorLimitLow4

SetColorLimitLow5

SetColorToleranceHigh

SetColorToleranceLow

SetColorWarningHigh

SetColorWarningLow

SetLimitHigh4

SetLimitHigh5

SetLimitLow4

SetLimitLow5

SetLimitMax

SetLimitMin

SetMarker

SetTypeAlarmLow

SetToleranceHigh

SetToleranceLow

SetTypeLimitHigh4

SetTypeLimitHigh5

SetTypeLimitLow4

SetTypeLimitLow5

SetTypeToleranceHigh

SetTypeToleranceLow

SetTypeWarningLow

SetTypeAlarmHigh

SetTypeWarningHigh

SetWarningHigh

SetWarningLow

SetAverage

SetBoxType

SetColorChangeType

SetCursorControl

SetEditAtOnce

SetExtendedOperation
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SetHysteresis

SetHysteresisRange

SetMax

SetMin

SetOffsetLeft

SetOffsetTop

SetOperation

SetOperationMessage

SetOperationReport

SetPasswordLevel

SetPictureName

SetProcess

SetSmallChange

SetTrend

SetVisible

SetZeroPointValue

SetZoom

SetPosition

SetRangeMax

SetRangeMin

SetPicDeactTransparent

SetPicDeactUseTransColor

SetPicDownTransparent

SetPicDownUseTransColor

SetPicTransColor

SetPicUpTransparent

SetPicUpUseTransColor

SetPicUseTransColor

SetBasePicTransColor

SetBasePicUseTransColor

SetFlashFlashPicture

SetFlashPicTransColor

SetFlashPicUseTransColor

SetFlashRateFlashPic

SetIndex
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SetBackBorderWidth

SetBorderEndStyle

SetBoxAlignment

SetBorderStyle

SetBorderWidth

SetFillStyle

SetFillStyle2

SetItemBorderStyle

SetItemBorderWidth

SetPressed

SetToggle

SetWindowsStyle

SetExponent

// ------------------------------------------------------------------------------------------------

// --- IVAR Support  ---

// ------------------------------------------------------------------------------------------------

// Tag with Wait and State

GetTagSDWordStateWait

GetTagBitStateWait

GetTagByteStateWait

GetTagSByteStateWait

GetTagWordStateWait

GetTagSWordStateWait

GetTagDWordStateWait

GetTagRawStateWait

GetTagDoubleStateWait

GetTagFloatStateWait

// Tag without Wait, with State

GetTagSDWordState

GetTagBitState

GetTagByteState

GetTagSByteState

GetTagWordState

GetTagSWordState

GetTagDWordState
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GetTagRawState

GetTagDoubleState

GetTagFloatState

// Tag with Wait (synchronous)

GetTagSDWordWait

GetTagBitWait

GetTagByteWait

GetTagSByteWait

GetTagWordWait

GetTagSWordWait

GetTagDWordWait

GetTagRawWait

GetTagDoubleWait

GetTagFloatWait

// Tag without Wait. (SCRIvar maps those to the respective Wait functions)

GetTagSDWord

GetTagBit

GetTagByte

GetTagSByte

GetTagWord

GetTagSWord

GetTagDWord

GetTagRaw

GetTagDouble

GetTagFloat

// Set with WriteVar, returns the State

SetTagBitStateWait

SetTagByteStateWait

SetTagCharStateWait

SetTagDoubleStateWait

SetTagDWordStateWait

SetTagFloatStateWait

SetTagSByteStateWait

SetTagSDWordStateWait

SetTagSWordStateWait
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SetTagWordStateWait

// Set with WriteVarasync and Ignore the Callbacks

SetTagBitState

SetTagByteState

SetTagCharState

SetTagDoubleState

SetTagDWordState

SetTagFloatState

SetTagSByteState

SetTagSDWordState

SetTagSWordState

SetTagWordState

// Set Values with WriteVar

SetTagBitWait

SetTagByteWait

SetTagCharWait

SetTagDoubleWait

SetTagDWordWait

SetTagFloatWait

SetTagSByteWait

SetTagSDWordWait

SetTagSWordWait

SetTagWordWait

// Set Values with WriteVarAsync(), ignore the Callback

SetTagBit

SetTagByte

SetTagChar

SetTagDouble

SetTagDWord

SetTagFloat

SetTagSByte

SetTagSDWord

SetTagSWord

SetTagWord

strcpy 
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strncpy 

strcat 

strncat 

strcmp 

strncmp 

strchr 

strrchr 

strspn 

strcspn 

strpbrk 

strstr 

strlen 

strerror 

strtok 

memcpy 

memmove 

memcmp 

memchr 

memset 

Supported ODK Functions
PWRTCheckPermission  

PWRTCheckPermissionOnPicture    // Only "permlevel" parameter is evaluated ! 

MSRTStartMsgService  

MSRTStopMsgService  

MSRTCreateMsg  

MSRTCreateMsgInstanceWithComment

MSRTSetComment

PDLRTGetLink

PDLRTSetLink

PDLRTGetPropEx  

PDLRTSetPropEx  

Supported User Archives Functions
uaArchiveClose
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uaArchiveDelete

uaArchiveExport

uaArchiveGetCount

uaArchiveGetFieldLength

uaArchiveGetFieldName

uaArchiveGetFields

uaArchiveGetFieldType

uaArchiveGetFieldValueDate

uaArchiveGetFieldValueFloat

uaArchiveGetFieldValueDouble

uaArchiveGetFieldValueLong

uaArchiveGetFieldValueString

uaArchiveGetFilter

uaArchiveGetID

uaArchiveGetName

uaArchiveGetSort

uaArchiveImport

uaArchiveInsert

uaArchiveMoveFirst

uaArchiveMoveLast

uaArchiveMoveNext

uaArchiveMovePrevious

uaArchiveOpen

uaArchiveReadTagValues

uaArchiveReadTagValuesByName

uaArchiveRequery

uaArchiveSetFieldValueDate

uaArchiveSetFieldValueFloat

uaArchiveSetFieldValueDouble

uaArchiveSetFieldValueLong

uaArchiveSetFieldValueString

uaArchiveSetFilter

uaArchiveSetSort

uaArchiveUpdate

uaArchiveWriteTagValues
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uaArchiveWriteTagValuesByName 

uaConnect 

uaDisconnect

uaGetLastError

uaGetLastHResult

uaQueryArchive

uaQueryArchiveByName

uaReleaseArchive

Note

User archive functions must always be configured to start with "ua" in lower case. If they are 
configured with "UA..." in upper case, then this is an ODK function and they are not supported 
in the Web client.

Supported MBCS Functions
_ismbcalnum

_ismbcalpha

_ismbcdigit

_ismbcgraph

_ismbcprint

_ismbcpunct

_ismbcspace

_ismbclower

_ismbcupper

_mbscpy

_mbsncpy

_mbscat

_mbsncat

_mbscmp

_mbsncmp

_mbschr

_mbsrchr

_mbsspn

_mbscspn

_mbspbrk
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_mbsstr

_mbstok

_mbslen

_mbsinc

_mbsdec

_mbsicmp

_mbsnicmp

_mbclen

_mbctolower

_mbctoupper

4.11.4.2  int WaitForDocumentReady(LPCSTR lpszPictureWindow)

Function
The function opens the specified picture window. The function terminates when the picture 
window has been loaded.

NOTICE

The function is only available in the WebNavigator and must therefore be enclosed by:
● #ifdef RUN_ON_WEBNAVIGATOR         ‌

…
● #endif

A difference must be made in the scripts of graphics displays or project functions between the 
WinCC Runtime environment or the WebNavigator Client. The following Compiler commands 
exist to this purpose:

● #ifdef RUN_ON_WEBNAVIGATOR

● #ifndef RUN_ON_WEBNAVIGATOR (the negation)

This allows the following configuration differentiations between WinCC and WebNavigator 
Client:

● Script delay with "WaitForDocumentReady"

● Differing picture addressing

● Differing function names at control system functions

● Functions that are not supported in the Web Client

Syntax
int WaitForDocumentReady(LPCSTR lpszPictureWindow)
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Parameters

lpszPictureWindow
Pointer to the name of the picture window that is opened in the WebNavigator Client.

The following addressings are possible:

● Picture window xxx in the current screen: ./xxx
● Picture window yyy in the child screen xxx: ./xxx/yyy
● etc.

● Picture window xxx in the parent screen: ../xxx
● Picture window xxx in the parent screen of the parent screen: ../../xxx
● etc.

● Absolute path compatible with WinCC

Return value

TRUE
The picture window has been found and the status checked.

FALSE
The picture window has not been found.

Example
#ifdef RUN_ON_WEBNAVIGATOR
SetPropChar("../", "View", "PictureName", szViewName);
WaitForDocumentReady("../View");
#else
SetPropChar(lpszParent, "View", "PictureName", szViewName);
#endif

Note

The syntax of the code part for the WebNavigator is not checked when the WinCC script is 
compiled, but only when the pictures are published.
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4.11.4.3 Unsupported Functions
The following list is only an excerpt of the unsupported functions and includes those functions, 
whose missing support is to be explicitly pointed out. 

Functions
ReportJob

RPTJobPreview 

RPTJobPrint

RptShowError 

GetHWDiag 

GetHWDiagLevel 

GetKopFupAwl 

GetKopFupAwlLevel 

OnDeactivateExecute

OnErrorExecute

OnTime

 

VBScript functions
HMIRuntime.Stop: Terminates the Internet Explorer and WinCCViewerRT, but not WinCC 
Runtime

AlarmLogs Object

DataLogs Object

Logging Object

Project Object

Functions That Are not Required:
ExitWinCC 

DeactivateRTProject: Terminates the Internet Explorer and WinCCViewerRT, but not WinCC 
Runtime

InquireLanguage 

FillDiagnoseInTags 

TraceText 

TraceTime 
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Other Functions

Note

These functions are included to ensure a faultless compilation on the Web Navigator Client, 
but are not supported by the web client. 

 

GmsgFunction  

MSRTMsgWinCommand  

AXC_OnBtnHornAckn

AXC_OnBtnPrint

AXC_OnBtnProtocol

TlgTableWindowPressHelpButton

GetCursorMode 

SetCursorMode 
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